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Typographic Conventions

Table 1

oomie o

<Example>

Angle brackets indicate that you replace these words or characters with appropriate entries
to make entries in the system, for example, “Enter your <User Name>".

b Example » Example 3

Arrows separating the parts of a navigation path, for example, menu options

Example

Emphasized words or expressions

Example

Words or characters that you enter in the system exactly as they appear in the
documentation

Www.sap.com

Textual cross-references to an internet address

/example Quicklinks added to the internet address of a homepage to enable quick access to specific
content on the Web
123456 Hyperlink to an SAP Note, for example, SAP Note 123456
Example ®  Words or characters quoted from the screen. These include field labels, screen titles,
pushbutton labels, menu names, and menu options.
® Cross-references to other documentation or published works
Example e  Qutput on the screen following a user action, for example, messages
®  Source code or syntax quoted directly from a program
® File and directory names and their paths, names of variables and parameters, and
names of installation, upgrade, and database tools
EXAMPLE Technical names of system objects. These include report names, program names,

transaction codes, database table names, and key concepts of a programming language
when they are surrounded by body text, for example, SELECT and INCLUDE

EXAMPLE Keys on the keyboard
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Document History

A Caution

Before you start the implementation, make sure you have the latest version of this document. You can find the
latest version on SAP Service Marketplace service.sap.com/instguides.

The following table provides an overview on the most important document changes:

Table 2
1.0 2013-08-08 Initial Version
11 2014-05-19 Minor enhancements in chapter 1 regarding SAP Fiori
References to Scenario & Process Component List (SCL/PCL) deleted (chapters 4.1, 4.4)
1.2 2015-01-30 As of support package 7 for SAP APQO 7.0 EHP 3, the following applications are not only
supported in an SCM Server installation, but also in an add-on on SAP ERP 6.0 EHP 6/7:
e  Applications that use Integrated Product and Process Engineering (iPPE), including the
following:
©  Model Mix Planning (MMP)
o Rapid Planning Matrix (RPM)
o Planned Order Management (POM)
o Action Handler
®  Planning with classification data (characteristics-dependent planning, variant
configuration) and planning with batch data
The section Make to Order for OEM was updated accordingly.
For more information, see the SAP Notes 2096165 (iPPE) and 2096140 (planning with
classification and batch data).
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1

Getting Started

Caution

This guide does not replace the daily operations handbook that we recommend customers create for their
specific production operations.

Designing, implementing, and running your SAP application at peak performance 24 hours a day has never been
more vital for your business success than today.

This guide provides a starting point for managing your SAP applications and maintaining and running them
optimally. It contains specific information for various tasks, and lists the tools that you can use to carry them out.
It also refers to documentation required for these tasks. You must use this guide in connection with other guides
such as the Master Guide, Technical Infrastructure Guide, and SAP Library.

Target Groups

Technical consultants
System administrators
Solution consultants
Business process owner

Support specialist

SAP Advanced Planning and Optimization (SAP APO) provides two deployment options:

SAP APO as part of SAP Supply Chain Management (SAP SCM)

This deployment option requires to use SAP enhancement package 3 for SAP SCM 7.0 (including SAP APO).
SAP enhancement package 3 for SAP SCM 7.0 is based on SAP NetWeaver 7.4.

SAP APO as add-on for SAP Enterprise Resource Planning (SAP ERP)

This deployment option requires to use either SAP enhancement package 3 for SAP APO 7.0 on SAP
enhancement package 6 for SAP ERP 6.0 or SAP enhancement package 3 for SAP APO 7.0 on SAP
enhancement package 6 for SAP ERP 6.0.

SAP enhancement package 6 for SAP ERP 6.0 is based on SAP enhancement package 3 for SAP NetWeaver
7.0.

SAP enhancement package 7 for SAP ERP 6.0 is based on SAP NetWeaver 7.4.

SAP Fiori apps

For more information regarding SAP Fiori apps, see SAP Library at help.sap.com/scm under SAP Fiori for SAP
SCM.

1.1

Global Definitions

SAP Application:

An SAP application is an SAP software solution that serves a specific business area like ERP, CRM, PLM, SRM,
SCM. It represents a market view on groups of related business scenarios. The delivery of an application contains
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SAP components that are essential for implementing all application-related business scenarios, processes and
functions. The implementation knowledge is allocated together with an application. For example, the SAP
application SAP SCM 7.0 consists of several components such as SAP SCM Basis 7.0, SAP SCM 7.0 Server, and

others.

Business Scenario:

From a microeconomic perspective, a business scenario is a cycle which consists of several different
interconnected logical processes in time. Typically, a business scenario includes several company departments
and involves other business partners. From a technical point of view, a business scenario needs at least one SAP
application (SAP ERP, SAP SCM, or others) for each cycle, and possibly other third-party systems. A business
scenario is a unit which can be implemented separately and reflects the customer’s prospective course of

business.

Component:

A component is the smallest individual unit considered within the Solution Development Lifecycle; components
are produced, delivered, installed, and maintained separately.

1.2

A Caution

Important SAP Notes

Check regularly for updates for the Application Operations Guide.

Table 3: Important SAP Notes

(Only relevant for SAP APO as part of
SAP SCM)

100740 Setting up a PCanywhere connectionin | This note describes how to setup a

the SAP frontend PCanywhere connection in the SAP
frontend.

592085 Installing the HTTP Connect service This note describes how to install the
HTTP Connect service.

605795 Windows Terminal Server connectionin | This note describes how to set up

remote support Windows Terminal Server connection in
remote support.

617547 RZ20: Sending alerts as mail and SMS Describes how to use transaction Rz20
to send alerts from the CCMS
monitoring architecture as an e-mail,
SMS, or other message types to one or
several recipients.

1118147 Report for deregistering invalid This note describes how to solve the

observers in IBINOBS

following problem: there is a large
volume of entries is caused by invalid
IBINOBS entries; observers which are
not used any more.
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1228423

APO Planning Run and CIF Activities in
parallel

This note describes how to solve the
following problem: planning runs of one
or several SAP SCM APO applications
are scheduled in parallel to data transfer
from SAP ERP to SAP SCM via the Core
Interface (CIF). Planning runs or CIF
updates report (locking) errors, or
planning results or CIF updates are
inconsistent or incomplete. These
errors can be caused by lock collisions
because CIF and a planning run might
change the same data (in most cases
the same order) concurrently.

1330450

Installation of SCM Optimizer Version
10.0

This note describes the implementation
of SCM Optimizer 10.0 .

SAP Advanced Planning and Optimization 7.0 Including Enhancement Package 3
Getting Started
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2 Technical System Landscape

2.1 Scenario/Component Matrix

For more information regarding the components necessary for business scenarios and processes, see the SAP
APO Master Guide on the SAP Service Marketplace at | service.sap.com/instguides » SAP Business Suite
Applications » SAP SCM » SAP APO » Using SAP enhancement package 3 for SAP APO Server 7.0 1.

2.2 Related Documentation

The following table lists where you can find more information about the technical system landscape:

Table 4
Guide/Tool Quick Link on SAP Service Marketplace
Application and industry- Master Guide |p service.sap.com/instguides 3
specific components, such as
SAP Financials and SAP Retail
Technology components such | Master Guide [P service.sap.com/instguides 3
as SAP NetWeaver
Sizing Quick Sizer Tool |» service.sap.com/sizing 2
Technical configuration Technical Infrastructure Guide — SAP | | service.sap.com/installNW70 3 or
NetWeaver 7.0 (or 7.4) |p service.sap.com/instalNW74 3
Scalability Technical Infrastructure Guide — SAP | | service.sap.com/installNW70 3 or
NetWeaver 7.0 (or 7.4) [P service.sap.com/installNW74 3
High availability Technical Infrastructure Guide — SAP | | service.sap.com/installNW70 3 or
NetWeaver 7.0 (or 7.4) | service.sap.com/installNW74 3
Security Security Guide [P service.sap.com/securityguide 3
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3 Monitoring of SAP Advanced Planning and
Optimization (SAP APO)

Within the management of SAP Technology, monitoring is an essential task. This section is therefore devoted
strictly to this subject.

For more information about the underlying technology, see SAP Library for SAP NetWeaver on SAP Help Portal at
help.sap.com/nw703 under [ SAP NetWeaver » Administrator’s Guide » Technical Operations for SAP
NetWeaver 1 or help.sap.com/nw74 under [ SAP NetWeaver » System Administration and Maintenance
Information » Technical Operations for SAP NetWeaver 1.

3.1 Alert Monitoring with CCMS

Proactive automatic monitoring is the basis for ensuring reliable operations for your SAP system environment.
SAP provides you with the infrastructure and recommendations needed to set up your alert monitoring to
recognize critical situations for SAP APO as quickly as possible.

3.11 CCMS Monitoring Installation and Setup

SAP APO is technically based on SAP NetWeaver and thus reuses monitoring tools from SAP NetWeaver, such as
the Computing Center Management System (CCMS). Therefore, we recommend that you set up the Monitoring
Infrastructure as described in the Monitoring Setup Guide for SAP NetWeaver located on SAP Service
Marketplace at [ service.sap.com/instguides » SAP NetWeaver » SAP NetWeaver 7.0 (Including Enhancement
Package 3) or SAP NetWeaver 7.4 » Operations » Monitoring 1.

The monitoring setup described in the Monitoring Setup Guide is the foundation for the following sections and
contains all the information relevant to monitoring the SAP NetWeaver components used in SAP APO. Proficient
knowledge of system monitoring and basic knowledge of SAP NetWeaver is required to compose the user-defined
APO monitors recommended within this guide.

To enable the auto-alert mechanism of CCMS, see SAP Note 617547.

For more information about monitoring, see SAP Library for SAP NetWeaver on SAP Help Portal at help.sap.com/
nw703, under [ SAP NetWeaver » SAP NetWeaver by Key Capability » Application Platform by Key Capability »
ABAP Technology » Administration of Application Server ABAP » Monitoring and Administration Tools for
Application Server ABAP 3 or help.sap.com/nw74, under [ SAP NetWeaver » SAP NetWeaver Library: Function-
Oriented View ¥ Application Server » Application Server ABAP » Monitoring and Administration Tools for
Application Server ABAP 1.
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3.1.2 Component-Specific Monitoring

You can use CCMS to monitor the following components:
e SAP SCM Basis

e SAPAPO

® SAPliveCache

e SAP SCM Optimizer

® |nternet Graphics Service (IGS)

For this purpose, SAP APO provides the following monitor sets, which can be accessed on the SAP Easy Access
screen, by choosing | Tools » CCMS » Control/Monitoring » CCMS Monitor Sets 3 (transaction Rz20):

e SAP SCM Basis Monitor Templates
Comprises the CIF Master Data Queue Monitor
e SAP SCM Monitor Templates
Comprises the monitors for SAP APO, SCM Optimizer, and SAP liveCache

1 Note

If you use a central monitoring system (CEN) to monitor the above-mentioned components, make sure that
this system works with SAP enhancement package 3 for SAP NetWeaver 7.0 (or SAP NetWeaver 7.4). Only
then can you use all monitorable data (for example monitoring templates) provided with SAP APO.

For more information about monitoring, see SAP Library for SAP NetWeaver on SAP Help Portal at help.sap.com/
nw703, under [r SAP NetWeaver Library » SAP NetWeaver by Key Capability » Application Platform by Key
Capability » ABAP Technology » Administration of Application Server ABAP » Monitoring and Administration
Tools for Application Server ABAP 3 or help.sap.com/nw74, under [ SAP NetWeaver » SAP NetWeaver Library:
Function-Oriented View » Application Server » Application Server ABAP » Monitoring and Administration Tools for
Application Server ABAP 1.

SAP SCM Basis (Part of SCM)

For more information about the monitoring of SAP SCM Basis, see

SAP APO

SAP SCM allows you to monitor CIF and gRFC related values, such as the status of CIF Compare Reconcile (delta
report), CIF postprocessing entries, the consumption of planned independent requirements, or an overview of
blocked gRFCs, but also SNP related values for master data and time series.

You can start the monitor in the SAP Easy Access screen by choosing [ Advanced Planning and Optimization »
APO Administration » Integration » Monitor » CCMS Monitor Sets » SAP SCM Monitor Templates » APO
Monitor 1.

For more information about setting up this monitor, see SAP Library for SAP Supply Chain Management, on SAP
Help Portal at help.sap.com/scm703, under [ SAP Supply Chain Management (SAP SCM) » SAP Advanced
Planning and Optimization (SAP APQO) » Integration via Core Interface (CIF) » Technical Integration » Core
Interface (CIF) » Administration » Monitoring » SAP APO Monitoring with CCMS 3.

If you want to monitor CIF using the SAP Solution Manager, see the Best Practice document System Monitoring
for mySAP SCM with SAP Solution Manager and CCMS (service.sap.com/~sapidb/
011000358700002213412003E).
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SAP liveCache Technology
You can use the SAP liveCache Alert Monitor to identify memory problems in good time, to check the security of
your SAP liveCache, and to monitor performance.
You can choose from the following displays for each SAP liveCache node in the monitoring tree:
®  Properties (displays the SAP liveCache properties, the SAP liveCache status, and error messages)
® Space Management (memory in the data area, log area, and main memory)

® Performance (cache hit rates, free database sessions for user tasks, the status of the write-protection for the
OMS monitor, and information about the optimizer statistics)

Backup/Recovery (information about backups and recoveries)
® Health (information about bad indexes and database structure checks)
e JiveCache Applications (information about the APO system)
® Fxternal Analysis Tools (information from the Database Analyzer)
You can use the following start options for the Alert Monitor:
® Onthe SAP Easy Access screen, call the DBA Cockpit (transaction DBACOCKPIT) and choose Alerts.
® Onthe SAP Easy Access screen, call the CCMS Monitor (transaction RzZ20) and choose [» SAP CCMS
Monitors for Optional Components » MaxDB Monitoring » liveCache 1.

For more information about the DBA Cockpit, see SAP Library for help.sap.com/maxdb under |» Tools » Database
Administration in CCMS: SAP MaxDB » DBA Cockpit: SAP MaxDB 3

Additionally, see the Best Practice document System Monitoring for mySAP SCM (3.0-4.1) with SAP Solution
Manager and CCMS (service.sap.com/~sapidb/011000358700002213412003E).

To use the CCMS Monitoring of SAP liveCache, you need to activate the Alert Monitoring in the DBA Cockpit
(transaction DBACOCKPIT). For more information about the DBA Cockpit, see SAP Library for help.sap.com/
maxdb under |» Tools » Database Administration in CCMS: SAP MaxDB » DBA Cockpit: SAP MaxDB 1.

Additionally, you need to schedule report /SAPAPO/OM LCAALERTS in regular intervals (see section SAP
APO [page 54] of this document). This report provides the information for the CCMS node liveCache Applications.

You can start the monitor on the SAP Easy Access screen by choosing [ Advanced Planning and Optimization »
APO Administration » Integration » Monitor » CCMS Monitor Sets » SAP SCM Monitor Templates » liveCache
Monitor 1.

You can also use the DBA functions of the CCMS to administer your MaxDB database system. See section SAP
liveCache Technology [page 38] of this document for details.

SAP SCM Optimizer

You can start the monitor on the SAP Easy Access screen by choosing [ Advanced Planning and Optimization »
APO Administration ¥ Integration » Monitor » CCMS Monitor Sets (transaction RZ20) » SAP SCM Monitor
Templates » SAP Optimizer 3.

Internet Graphics Service

The Internet Graphics Service (IGS) is part of SAP NetWeaver, and it is used on SAP SCM screens to support the
display of graphics. Since SAP SCM also uses the IGS, you should also monitor this component. CCMS gives you
an overview of the current IGS configuration, the port watchers available, and their associated interpreters. It also
displays various performance values for the relevant IGS components.

To monitor IGS in CCMS, you must activate CCMS Monitoring. You can do so by starting the
GRAPHICS IGS_ADMIN reportin transaction sE38. Then enter IGS RFC-Destination and choose|rg| Then
select the menu Environment and choose Switch on CCMS.
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You can find the monitor tree for IGS in the CCMS (transaction Rz20) as the Internet Graphics Server in the
monitor set SAP CCMS Monitors for Optional Components.

For more information about the values displayed in CCMS, see SAP Library for SAP NetWeaver on SAP Help
Portal at help.sap.com/nw703, under [ SAP NetWeaver » SAP NetWeaver by Key Capability » Application
Platform by Key Capability » ABAP Technology » Ul Technologies in ABAP » Further Ul Technologies » SAP
Graphics » Internet Graphics Service » Administering the Internet Graphics Service (IGS) 2 or help.sap.com/
nw74, under | SAP NetWeaver » SAP NetWeaver Library: Function-Oriented View » Application Server »
Application Server ABAP » Ul Frameworks Based on Application Server ABAP » Further Ul Technologies » SAP
Graphics ¥ Internet Graphics Service » Administering the Internet Graphics Service (IGS) 1.

3.2 Detailed Monitoring and Tools for Problem and
Performance Analysis

SAP APQ is technically based on SAP enhancement package 3 for SAP NetWeaver 7.0 (or SAP NetWeaver 7.4).
For information about technical problem analysis (such as for database, operating system, or workload analysis),
see SAP Library for SAP NetWeaver on SAP Help Portal at help.sap.com/nw703, under |+ SAP NetWeaver »
Administrator’s Guide » Technical Operations for SAP Netweaver 1 or help.sap.com/nw74, under | SAP
NetWeaver » System Administration and Maintenance Information » Technical Operations for SAP Netweaver 1.
This SAP APO Application Operations Guide only covers the differences and additional information specific to SAP
APO.

3.21 SAP SCM Basis (Part of SCM Server)

For information, see Application Operations Guide for Supply Chain Management 7.0 including SAP enhancement
package 3 in SAP Service Marketplace at service.sap.com/instguides, under [ SAP Business Suite Applications »
SAP SCM » SAP SCM Server » Using SAP Enhancement Package 3 for SAP SCM 7.0 1.

3.2.2 SAP APO Analysis Tools

For information about internal and external monitoring, problem, and performance analysis tools, see the
following Best Practices document:

Internal and External Consistency for SAP APO (3.x) / mySAP SCM (4.x) (service.sap.com/~sapidb/
011000358700002214842003E)

For performance monitoring in SCM 7.x, see the documentation on the APO Performance Monitor on SAP Help
Portal at help.sap.com/SCM703, under [k SAP Supply Chain Management (SAP SCM) » SAP Advanced Planning
and Optimization (SAP APO) » SAP APO Administration » APO Performance Monitor 1.

Depending on the business processes you are using in APO, you can find additional information in the following
Best Practices documents:

® Manage Demand Planning in SCM/APO (service.sap.com/~sapidb/011000358700000955412003E)
®  Manage Supply Network Planning in SCM / APO (service.sap.com/~sapidb/011000358700004718192003E)
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®  Manage Production Planning in SAP APO (3.x) / mySAP SCM (4.x) (service.sap.com/~sapidb/
011000358700008416512001E)

®  Manage Global ATP in SAP APO (3.x) / mySAP SCM (4.x) (service.sap.com/~sapidb/
011000358700007382482002E)

® Manage the Transportation Management Solution in SAP APO (3.x) / mySAP SCM (4.x) (service.sap.com/
~sapidb/011000358700007382622002E)

Trace and Log Files

Trace and log files are essential for analyzing problems.

For general information about traces, see SAP Library for SAP NetWeaver on SAP Help Portal at help.sap.com/
nw703, under [ SAP NetWeaver » SAP NetWeaver by Key Capability » Application Platform by Key Capability »
ABAP Technology » Administration of Application Server ABAP » Monitoring and Administration Tools for
Application Server ABAP » Trace Functions 1 or help.sap.com/nw74, under | SAP NetWeaver » SAP NetWeaver
Library: Function-Oriented View » Application Server » Application Server ABAP » Administration of Application
Server ABAP » Monitoring and Administration Tools for Application Server ABAP » Trace Functions 1.

For general information about application logs, see SAP Library for SAP NetWeaver on SAP Help Portal at
help.sap.com/nw703, under | SAP Netweaver » SAP NetWeaver by Key Capability » Solution Life Cycle
Management by Key Capability » Application Log 3 or help.sap.com/nw74, under |» SAP Netweaver » SAP
NetWeaver Library: Function-Oriented View » Solution Life Cycle Management » Application Log 2.

Table 5: Log objects and subobjects to be used for SAP APO in SLG1

Log Object Log Subobject Object/Subobject Text Only for SAP APO as part of
SAP SCM
AHT N/A X

Action Handler and
Production Tracking

N/A ACTION HANDLER CORE | Core Action Handler X

APO N/A Advanced Planning and
Optimization

N/A ATP APO Global ATP

N/A CHK Consistency Check for CTM
Master Data

N/A CTM Capable-to-Match

N/A DOWN_UPLOAD Download and Upload
liveCache Data

N/A DP-RTO Runtime Object

N/A EDQA Event-Driven Quantity
Assignment (EDQA)

N/A LCCHECK RPM Matrices Test with X
liveCache Check

N/A MD Master Data

N/A MVM Model/Version Management

SAP Advanced Planning and Optimization 7.0 Including Enhancement Package 3
Monitoring of SAP Advanced Planning and Optimization (SAP APO)
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http://help.sap.com/nw703
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Log Object Log Subobject Object/Subobject Text Only for SAP APO as part of
SAP SCM

N/A ND Network Design

N/A PPDS Production Planning and
Detailed Scheduling

N/A PPM Production Process Model

N/A PP DTS Production Planning and
Detailed Scheduling

N/A RECOVERY Recovery

N/A SCO Sales Scheduling Agreement

N/A SDPP Consistency Check for
Planning Books

N/A SRC Source of Supply
Determination

N/A SWITCH liveCache Change/Upgrade

N/A TPVS Transportation Planning and
Vehicule Scheduling

N/A UPGRADE Errors that occurred during
the upgrade

N/A VERSIONMERGE SNP Version Merge

APO_BAPI N/A CommunicationAPO—
External Systems

N/A ATP APS ATP Service Object

N/A CLP_APS APS Collaborative Planning

N/A DEL REP Deletion Report for
Transaction Data

N/A FC_APS PlannedindRegmtsAPS

N/A KFIG_ SEND REP Transfer Report for Key
Figure Values

N/A LOC_APS APS Location

N/A LPH_APS Location Product Hierarchy
APS

N/A LPSP_APS APS Location Product
Substitution Procedure

N/A LSP_APS APS Location Determination
Procedure
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Log Object

Log Subobject

Object/Subobject Text Only for SAP APO as part of

SAP SCM

N/A MDAT SEND REP Transfer Report for Master
Data

N/A MO APS APS Manufacturing Order

N/A OR_APS APS Order Request

N/A PB_APS APS Planning Block

N/A PDS_APS Production Data Structure
APS

N/A PH APS Product Hierarchy APS

N/A PLOC_APS APS Partner Location

N/A PL_EVENT Planning Event

N/A PO _APS APS Procurement Order

N/A PPDS_APS PP/DS Planning Services

N/A PPMSP APS APS PPM Substitution
Procedure

N/A PPM_APS APS Production Process
Model

N/A PPRD_APS APS Partner Product

N/A PRD_APS Product APS

N/A PRM_APS APS Promotion

N/A PSP _APS APS Production Substitution
Schema

N/A QT APS APS Quota Arragement

N/A REQ APS APS Request for Quotation

N/A RES_APS APS Resources

N/A RULE APS APS Substitution Rule

N/A SEND REP Transfer Report for
Transaction Data

N/A SO_APS APS Sales Order

N/A ST_APS APS Stock

N/A TRL_APS APS Transportation Lane

N/A VS_APS Vehicule Scheduling Services

APS

SAP Advanced Planning and Optimization 7.0 Including Enhancement Package 3
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Log Object Log Subobject Object/Subobject Text Only for SAP APO as part of
SAP SCM

APO_FCS N/A Log for APODP Applications

N/A ADD_ BOM Add Bill of Materials
Information

N/A BCSP Consumption in the
Background

N/A DPC Demand Planning
Characteristic Value
Combination

N/A DPF Demand Plan Selection

N/A DPP Demand Plan

N/A DPS Demand Planning Scenario

N/A DPT Demand Planning Scenario
Template

N/A DPV Demand Plan Version

N/A DVOP Demand View of Promotion

N/A EXT RELEASE Extended Release to Supply
Network Planning

N/A FCS Planning

N/A GFC Generate Forecasting

N/A MD CHECK Subobject for Master Data
Checker

N/A PAREA LOAD Load Data from InfoCube into
Planning Area

N/A PA CHANGE Change Planning Area

N/A PSTRU Planning Object Structure

N/A RELEASE Release to Supply Network
Planning

N/A RELEASE CUBE_TO_OLTP | Direct Release from
InfoProvider ot ERP System

N/A RELEASE CUBE TO SNP | Direct Release from
InfoProvider to SNP

N/A REO Forecasting Reorganisation

N/A SDP94 Interactive Planning

N/A SEASON Seasonal Planning
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Log Object Log Subobject Object/Subobject Text Only for SAP APO as part of
SAP SCM
N/A SO Selection Organization
N/A TS Time Series Management
N/A TS BATCH DP Mass Processing
N/A TS _PROP Calculate Proportional
Factors
N/A VERSION COPY Copy Planning Version
N/A XLS UPLOAD Excel Upload in Interactive
Planning
N/A EVTY DEL Deletion of Event Types with
Dependencies
N/A FCS_OPT Classification and Forecast
Optimization
N/A MASS EVDEL Mass Deletion of Events
N/A MASS EVENT Mass Creation of Events
N/A OUTLIER DETECT Detection of Outliers
APO_SNP N/A APO: Supply Network
Planning
N/A AGG SNP Aggregation
N/A CAP Capacity Leveling
N/A DEP SNP Deployment
N/A DIS SNP Disaggregation
N/A DISR SNP Disaggregation After
Resource Consumption
N/A DPLOPT Deployment Optimization
N/A FRWK SNP Characteristic
Framework
N/A HEU SNP Heuristic
N/A LLC SNP Low-Level Code
Determination
N/A OPT SNP Optimization
N/A RELEASE Release to Demand Planning
N/A RLCDEL Delete Transaction Data
N/A SFT SNP Safety Stock Planning
PUBLIC
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Log Object Log Subobject Object/Subobject Text Only for SAP APO as part of
SAP SCM
N/A SHLF SNP Propagation of Shelf Life
Dates
N/A SLM Single-Level Supply and
Demand Planning
N/A SPL Prioritization of Deployment
Stock Transfers
N/A TLB TLB: Transport Load Builder
APO_MD N/A APO: Master Data
N/A LO Location
N/A STD_HIER CREATE Report: Create Standard
Hierarchy
N/A VM Version Management
APOPCM N/A Production Campaign in APO
N/A APOPCMDPS Production Campaign in DPS
CIFSCM N/A Application Log Object for
Core Interface
N/A DL Delivery (Inbound)
N/A SH Transport (Inbound)
N/A SHIPMENT Transports
INC N/A Product and Location
Substitution
MMP N/A Model Mix Planning and X
Sequencing
N/A MMP_ RUN Model Mix Planning Run X
N/A SEQ API External Interface/ X
Production Connection
N/A SEQ EXPERT CHANGES Expert Functions for X
Sequencing
N/A SEQ INTERACTIVE Interactive Sequencing X
MSP N/A Maintenance and Service X
Planning
N/A DMND Maintenance Demand X
MSP CIF N/A Maintenance and Service X
Planning — CIF
PUBLIC
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Log Object Log Subobject Object/Subobject Text Only for SAP APO as part of
SAP SCM

MSP MTL N/A Maintenance and Service X
Planning — Maintenance
Task List

RCC N/A Remote Control and
Communication

RESOURCE N/A Resources

RPM N/A Rapid Planning Matrix X

N/A FATAL ERRORS Fatal Errors X

N/A REORG Reorganize Data Vectors X

N/A RPM_ RUN Messages During RPM Run X

N/A TIMELINES Create RPM Time Series in X
Background

RPM_LCC N/A Test of RPM liveCache X
Routines

N/A HEADER General Data fora TestRun | X

N/A MESSAGES Individual Messages of a Test | X
Run

RPM LCC TESTTOOL N/A RPM Test Tool X

/SAPAPO/CMDS N/A Collaborative Management of
Delivery Schedules (CMDS)

N/A CHECK Consistency Check

/SAPAPO/CONFR_CFGREL | N/A Consistency of Configuration
Relevance in Product Master

N/A CFGREL Configuration-Relevant
Product

N/A CLCH_RM Remove Characteristic from
CDP-Relevant Class

N/A MAT CONS Product Master Consistency

/SAPAPO/CONFR_PCHECK | N/A Material Variants Check

/SAPAPO/MCO1 N/A Planning with CDP

N/A BLOCK Block Planning

N/A CFGSYS Setting Up Configuration
Relevance

N/A MASTER Master Data

SAP Advanced Planning and Optimization 7.0 Including Enhancement Package 3
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Log Object Log Subobject Object/Subobject Text Only for SAP APO as part of

SAP SCM

N/A MAT Product Master

N/A TRANS Transactional Data
/SAPAPO/MC013X40 N/A CDP IBASE Conversion

/SAPAPO/RTO N/A Production Data Engine

N/A DELETE Delete Production Data

Structure
N/A DP_GEN Generate or Update

Production Data Structures

N/A EXPLODE PPDS Explosion for PP/DS
N/A EXPLODE SNP Explosion for CTM/DP/SNP
N/A PPDS_GEN Generate PP/DS Production

Data Structure

N/A PPE_GEN Generation of Production
Data Structures from iPPE
Data

/SCMB/MD N/A SCM Basis Master Data

N/A SCU Supply Chain Unit

For more information about trace and log files, see also the Best Practices documents mentioned in this section.

3.2.3 SAP liveCache Technology Analysis Tools

To monitor and administer your SAP liveCache, you have several options or tools, which should be used in the
following order of preference:

Table 6
N e
DBA Cockpit (DBACOCKPIT) You can use the DBA Cockpit to monitor | N/A
multiple SAP liveCaches on one or more
servers.
SAP MaxDB Database Studio The SAP MaxDB Database Studio The Database Studio is a Java
(referred to as Database Studio) is a application and is developed with the
newly-developed tool for the Eclipse programming tool (Eclipse
administration of SAP MaxDB platform). You can transfer the
databases. It combines the functions of | databases that you manage with the
it's predecessors Database Manager Database Manager GUI to the Database
GUI' (DBMGUI) and SQL Studio. As a Studio because they was stored in a
XML file.
PUBLIC
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result, a single integrated tool is now
available for the two previously
separated application areas
Administration and SQL-Client. The
Database Studio also provides
enhanced features with regard to its two
predecessors (part of it is, for example,
the loader that belongs to SAP MaxDB).

Database Manager CLI (DBMCLI)

An SAP liveCache command line
database client administration tool that
can be executed from within SAP APO
using transaction SM49.

Database Manager CLI is a command
line tool and is suited to both interactive
operation and batch operation. It can be
used on all operating systems
supported by the database system and
is part of the SAP MaxDB software
package.

N/A

For more information about the database tools, see SAP Library for SAP NetWeaver on SAP Help Portal at
help.sap.com/maxdb under Tools.

You can download the installation package for the Database Studio from the SAP Software Download Center at
service.sap.com/swdc under [p Software Downloads » Database Patches » MaxDB and SAP DB » MaxDB GUI
Components/Tools 1.

Table 7
Monitoring Object | Monitor

Transaction/Tool

Monitor Indicator or Error

Frequency

Monitoring Activity

or Error Handling
Procedure

Responsibility

Display current

/SAPAPO/0OMO04

As required or Check that correct

Check which LCA

System

LCA versions or /SAPAPO/ after SPs and versions are build is installed on | monitoring team
OM13 (see below) | upgrades installed your SAP liveCache
server

Test program for /SAPAPO/OMO03 | Asrequired or Correctly Performs asimple | System
SAP liveCache and after SPs and configured SAP check for LCA monitoring team
LCA routines upgrades liveCache and LCA | routines and SAP and/or Basis

routines should liveCache: useful to | Support

have output such | check the correct

as liveCache installation of SAP

test at LCA liveCache and/or

finished LCA routines

without

errors
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Monitoring Object | Monitor Monitor Indicator or Error | Monitoring Activity | Responsibility
Transaction/Tool | Frequency or Error Handling
Procedure
Analyze SAP /SAPAPO/OM13 | Daily / regularly Shows LCA build, System
liveCache and LCA checks important monitoring team
build SAP liveCache and
LCA build, checks
network speed/
status (see below),
shows SAP
liveCache log files
Display meaning of | /SAPAPO/OM10 | Asrequired Use to help Shows the meaning | Basis Support
LCA routine return analyze LCA of return codes
code routine messages | issues by LCA
or errors routines
SAP liveCache /SAPAPO/OM16, | Asrequired Can be used to see | Shows the size of Basis and
data viewer Display Plan the approximate data by planning Application
Version then size of planning version (in KB) Support
choose Calculate versions in SAP
in the output list liveCache
Check consistency | /SAPAPO/OM17 | Daily / weekly / as | Check for For more System

of data between
APO and SAP
liveCache

required

inconsistencies
and correct as
necessary

information, see the
Best Practice
Internal and
External
Consistency for
SAPAPO 3.x/
mySAP SCM
4.x/5.0
(service.sap.com/
~sapidb/
011000358700002
214842003E)

monitoring team
(Basis and
Application
Support)

Display SAP
liveCache OMS
and LCA routines
performance
analysis
information

PUBLIC
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Monitoring Object | Monitor

Transaction/Tool

Monitor
Frequency

Indicator or Error

Monitoring Activity | Responsibility

or Error Handling
Procedure

versions; active
transactions

SAP Advanced Planning and Optimization 7.0 Including Enhancement Package 3

Tool, see below

Monitoring of SAP Advanced Planning and Optimization (SAP APO)

SAP liveCache and
LCA routines

SAP liveCache and | /SAPAPO/OM14 | Daily / weekly/ N/A The test cockpit Basis Support
liveCache after upgrade or contains many
Applications test SP reports that are
cockpit available for testing
SAP liveCache and
LCA routines. It can
be used for
performance
comparisons/tests.
Evaluate SE38 -/ Weekly / after Check to see if Tests SAP Performance
performanceand | SAPAPO/OM upgrade or SP performance of liveCache and LCA | monitoring team
verify SAP PERFORMANCE SAP liveCache and | routines based on
liveCache and LCA | caxecute> LCA routines benchmark data.
routines [Default 5 sec] differs greatly from | Results can be used
previous runs to roughly compare
performance and
ensure SAP
liveCache / LCA
routines are
working well
Database Analyzer | You can call the Weekly / after Check to see if The Database Performance
Database Analyzer | upgrade or SP performance of Analyzer program | monitoring team
in several different SAP liveCache and | is a tool for
ways: LCA routines analyzing the
e From the differs greatly from | performance of
operating previous runs database instances.
system level For more
using information, see
command SAP Help Portal at
dbanalyze help.sap.com/
r maxdb.
® Inthe
Database
Manager CLI
® |nthe CCMS
(for SAP
systems)
Workload STO3N Weekly / after Check to see if N/A Performance
Workload Analysis upgrade or SP performance of monitoring team
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Monitoring Object | Monitor Monitor Indicator or Error | Monitoring Activity | Responsibility

Transaction/Tool | Frequency or Error Handling

Monitoring and Testing LCA and SAP liveCache Transactions

Procedure

differs greatly from
previous runs

LCA traces grow very large, very quickly. Therefore, never run LCA traces unattended and always ensure that they
are switched off immediately afterwards, otherwise disk-full situations might occur in a very short space of time.

Despite this, several transactions can be used (often in combination) to help assess what is occurring in SAP
liveCache and the running LCA routines.
To monitor transactions currently running in SAP APO and SAP liveCache, you may need to use several
transactions or tools:
® Transaction sM50 or sM66 (for all application servers):
Choose Process overview, look for DB procedure <procedure name>; match the PID here to the APPL PID
seen in the DBACOCKPIT Active or Runnable Tasks screens to see which SAP APO work process is connected
and working in SAP liveCache.
® Transaction DBACOCKPIT:
Choose |r Performance » Task Manager » Active Tasks or Runnable Tasks 1 — shows currently active tasks in

SAP liveCache, or runnable tasks that are waiting for either SAP liveCache processing time or a response
from SAP APO/ABAP programs. See SAP Note 454653 for the meaning of each status in these screens.

Process Overview

QOEBWA M ST &F B

B &S B TAZE| 0

SM50
DB procedure = task running in SAP
liveGache

[0 bIa 18128 stopped CPIC Yes
(1 b5 EEEEENE Funning Yes
= ﬁaﬁn 28543 waiting Yes

1 SRPLIRFC 001 ALEWSER
1FE24  JHRFAFOFER B8 BHHFESS 0B procedurs

1 e e L RS

d DA 2863 Runing Yow SERPAPICER G0 ALENGER Sanuential read
[ Fureitng e ] YEL_EM_APK G0 ALENEER puuet iyl e
5oax( 20073 ) Runeing ez 179 JEAFAPOSSA G91 SRPERT

liveCache Console: Active Tasks

&

PID in SM50 is shown as APPL pid in
LC10 console

Kotive tasks

RERVERDE: LCP

10 UKT  UNIX TYPE
tid

1137 _1n 28 User

AFFL  Current Timeout  Region Haiting
State Priority cnt try  Id or Time
Deonlbical Ted 81892 @ 115

LC10 — Active Tasks
DcomObjCalled = LCA routine
running/called

Figure 1

Other standard basis tools can also be used for monitoring SAP liveCache and LCA routines:
® Transaction SE30:

ABAP runtime analysis.
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1 Note
This may not distinguish between SAP APO database and SAP liveCache accesses

® Transaction STO5:

SQL Trace (may become extremely large — do not leave traces running unattended), see SAP Note 483854.

Network Monitoring Between SAP liveCache and Application Server

If the SAP APO system and the SAP liveCache are on physically separate servers, you should regularly (daily)
check the network performance between the two servers using the NIPING tool. Poor network performance can
lead to slow response times. These slow response times may suggest poor SAP liveCache performance, but in
fact are due to the network. To check this, read SAP Note 458221 and consider using the NIPING functionality in
transaction /sapaPO/0M13 on the Network tab page.

Workload Analysis Tool: Transaction STO3N

To help you determine the SAP liveCache elements of total response times with an SAP APO system, use
transaction STO3N.

More information about this tool is available with the help function and in the latest versions of the help
documentation.

STO03N offers three views: Service Engineer, Administrator, and Expert. For history information about response
times by days (for comparison purposes), you must be in Expert mode and have all necessary authorizations.

If you view the workload on a server, you can see the response times broken down by type (such as dialog, batch,
or RFC), and under the column DB Proc Time you can see the SAP liveCache percentage or portion of total
response times.

Transaction ST03N is especially useful for analyzing whether you have a bottleneck or SAP liveCache performance
issue on your system. It can also be used to see how changes of LCA build and SAP liveCache parameters have
affected your system.

Other features are available, such as transaction profiles, but the SAP liveCache processing time is separated out
to help you monitor and analyze your system in more detail.
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Time spent in liveCache

Figure 2

Trace and Log Files

Trace and log files are essential for analyzing problems.

Every SAP liveCache system message is stored in a log file called kn1diag. You should check this file within the
SAP APO System using transaction DBACOCKPIT (call transaction DBACOCKPIT then choose [F Diagnostics »
Messages » Kernel Messages ). The knldiag file is limited in size (SAP liveCache parameter kerneldiagsize,
default 800 KB). Once this size limit has been reached, the messages in that file are overwritten in a round robin.
One exception to this are messages relating to starting the database in the operational state AbM1IN.

1 Note

The knldiagfileis saved to knldiag.old during an SAP liveCache restart. For error analysis, save the
knldiag files before they are overwritten on subsequent restarts of SAP liveCache. Depending on the
installation, you can find the knldiag file at operating system level in the directory /sapdb/data/wrk/
<liveCacheName>.

Another important log file is knldiag.err. All SAP liveCache errors are recorded in this file. You can view this file
using transaction DBACOCKPIT (or at operating system level in the same directory as the kn1diag file). This file is
useful for SAP liveCache error analysis. After every restart of your SAP APO System, check the initialization log of
SAP liveCache. You can do so in transaction DBACOCKPIT (call transaction DBACOCKPIT then choose

|F Diagnostics » Messages » liveCache Operating » Current 3). Again, depending on your installation, you can find
it at operating system level in the directory /sapdb/<liveCacheName>/db as file 1cinit.log.

For serious error analysis, you may need to use a kernel or LCA trace. Only use these traces in coordination with
SAP Active Global Support since they can heavily influence system performance.

For more information about switching on a kernel trace, see SAP Library for SAP NetWeaver on SAP Help Portal at
help.sap.com/maxdb.

To turn on/off LCA traces, use transaction /SAPAPO/0OMO02. To view LCA trace files, use transaction /SAPAPO/
OMO1.
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1 Note

Ensure that your file system has enough disk space available to store all log files. For more information, see the
SAP liveCache Technology Installation Guide on the SAP Service Marketplace at [ service.sap.com/
instguides » SAP NetWeaver » SAP NetWeaver 7.0 (or 7.4) » Installation » Installation — Standalone Engines »
Installation SAP liveCache Technology 3 and SAP Note 429215.

Table 8: Important Log and Trace Files
e
e Database start and stop knldiag /sapdb/data/wrk/

®  Specifications about the physical memory areas <liveCacheName>

®  User processes

e  System error messages

Same messages as in knldiag created before SAP knldiag.old /sapdb/data/wrk/
liveCache restart <liveCacheName>
All error messages and warnings of the SAP liveCache kernel | knldiag.err /sapdb/data/wrk/
since the installation of the SAP liveCache <liveCacheName>
Starting, stopping, and initialization of the SAP liveCache lcinit.log /sapdb/data/wrk/

<liveCacheName>/db

All reactions of the database kernel to database statements | knltrace /sapdb/data/wrk/
<liveCacheName>/db

For more information about trace and log files, see SAP Library for SAP NetWeaver on SAP Help Portal at
help.sap.com/maxdb under Troubleshooting.

3.2.4 SAP SCM Optimizer Analysis Tools

Once SAP SCM optimizers have been correctly installed and configured, they require little or no administration
and maintenance. This section lists the most important transactions for optimizers with information about what
they are used for.

Table 9
Monitoring Object | Monitor Monitor Indicator or Error | Monitoring Responsibility
Transaction/Tool | Frequency Activity or Error
Handling
Procedure
User list for rcc_session As required N/A Displays a user list | Basis Support
optimizers for optimizers
Versions of rcc version As required N/A Displays optimizer | System monitoring
optimizers versions team
Running optimizer | rcc_session As required N/A Display optimizer | Basis Support
processes processes
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Monitoring Object

Monitor
Transaction/Tool

Monitor
Frequency

Indicator or Error

Monitoring
Activity or Error
Handling
Procedure

Responsibility

information of
optimizer runs

RFC destinations | SM59 / During installation | Test connection Defining and System monitoring
for optimizers rcc_cust or after status to ensure all | checking optimizer | team and Basis
configuration is OK RFC destinations — | Support
changes can also be used to
check if optimizer
serveris online
Spool file of SM37 As required Messages in spool | Check also for Application
optimizer run file application errors | Support / Job
after the optimizer | scheduling team
run using
rccf log(see
section Trace and
Log Files).
Detailed /SAPAPO/ As required N/A Display runtime Application
performance PERFMON details Support

Depending on the business processes you are using, we recommend that you also look at the following

documents:

®  Manage Supply Network Planning & CTM in SAP APO (3.x) and SAP SCM (4.x, 5.x) (service.sap.com/
~sapidb/011000358700004718192003E)

® Manage Production Planning in SAP APO (3.x) / mySAP SCM (4.x, 5.0) (service.sap.com/~sapidb/

011000358700008416512001E)

® Manage the Transportation Management Solution in SAP APO (3.x) / SAP SCM (4.x, 5.x) (service.sap.com/
~sapidb/011000358700007382622002E)

Trace and Log Files

Trace and log files are essential for analyzing problems.

Table 10: Important Log and Trace Files

Monitoring Object | Monitor

Transaction/Tool

Monitor
Frequency

Indicator or Error

Monitoring
Activity or Error
Handling
Procedure

Responsibility

Optimizer logs and
trace files

PUBLIC

rcc_log

To display the
trace files, choose
|+ Extras ¥ Display
Log File 3

Check frequently —
daily, weekly
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Check for Errors

Display and
analyze optimizer
logs and trace files.

These files are on
the serverin the
directory log of the
SAP gateway on

Basis Support
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Monitoring Object | Monitor

Transaction/Tool

Monitor
Frequency

Indicator or Error

Monitoring
Activity or Error
Handling
Procedure

Responsibility

which the
optimizers are
installed (either
your own server or
application, SAP
liveCache or
database server):
Directory
(Windows version):
\usr\sap\
<SID>\G<GWNIr>
\logor\usr
\sap\<SID>
\DVEBMGS
<GWNr>\log

<SID>=
SystemlID for
example, APO

<GWNr>=
SystemNr
(=GatewayNr) for
example, 00

For more
information, see

torccf log)

logs

SAP Note 391808.
Changing the /SAPAPO/OPT10 | Onlyin As directed by SAP | As directed by SAP | Basis Support
detail level of trace coordination with | Support Support
files SAP
Spool file of SM37 As required Messages in spool | Check also for Application
optimizer run file application errors | Support / Job
after the optimizer | scheduling team
run using
rccf log(see
above).
Displaying log files | /SAPAPO/ Check frequently — | Check for Errors Display and Basis Support
(as an alternative | PERFMON daily, weekly analyze optimizer

Depending on the business processes you are using, we recommend that you look at the following documents on
SAP Service Marketplace at service.sap.com:

SAP Advanced Planning and Optimization 7.0 Including Enhancement Package 3
Monitoring of SAP Advanced Planning and Optimization (SAP APO)

PUBLIC

© Copyright 2015 SAP SE or an SAP affiliate company.

All rights reserved.



http://service.sap.com/~form/handler?_APP=01100107900000000342&_EVENT=REDIR&_NNUM=391808&_NLANG=en&_NVERS=0
http://service.sap.com

®  Manage Supply Network Planning & CTM in SAP APO (3.x) and SAP SCM (4.x, 5.x) (service.sap.com/
~sapidb/011000358700004718192003E)

® Manage Production Planning in SAP APO (3.x) / mySAP SCM (4.x, 5.0) (service.sap.com/~sapidb/
011000358700008416512001E)

® Manage the Transportation Management Solution in SAP APO (3.x) / SAP SCM (4.x, 5.x) (service.sap.com/
~sapidb/011000358700007382622002E)

Distributed Statistical Records (DSR)

For each optimization run one DSR, containing technical data (for example runtime and memory consumption),
can be written to the file system. For more information, see SAP note 1088212.

3.2.5 SAP Service Parts Management

1 Note
This feature is not part of the SAP APO add-on and is currently only available in SAP APO as part of SAP SCM.

When you deploy the Service Parts Management scenario, you can check the application logs using the following
transactions:

Table 11
/SAPAPO/PE LOG DISP Log display N/A
SLG1 Application log display N/A

Trace and Log Files

Trace and log files are essential for analyzing problems.

For more information about traces, see SAP Library for SAP NetWeaver on SAP Help Portal at help.sap.com/
nw74, under |» SAP NetWeaver » SAP NetWeaver Library: Function-Oriented View » Application Server »
Application Server ABAP » Administration of Application Server ABAP » Monitoring and Administration Tools for
Application Server ABAP » Trace Functions 1.

For general information about application logs, see SAP Library for SAP NetWeaver on SAP Help Portal at
help.sap.com/nw74, under |» SAP NetWeaver » SAP NetWeaver Library: Function-Oriented View » Solution Life
Cycle Management » Application Log 3.

The application log can be accessed using the above mentioned transactions.

Table 12: Log objects and subobjects to be used for SPP in /SAPAPO/PE_LOG_DISP (or SLG1)

Log Object Log Subobject Object/Subobject Text

/SAPAPO/PE N/A Planning Service Manager

N/A PE_RUNTIME Planning Service Manager *)

N/A <SPP-related subobjects> Subobjects with name or text starting
with / containing SPP
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Log Object Log Subobject Object/Subobject Text

SCM_SPL_REP N/A Supply Chain Management: Service
Parts Logistics Reporting

N/A SCR_BASIS Supply Chain Analytical Tools

N/A SCR_BO_EQ Error Queue for Business Objects

N/A SRVF Service Fill

N/A SRVLOSS Ul for Service Loss Analysis

*) PE_RUNTIME is used for logging the most important errors during the execution of a Planning Service Manager

(PSM) run.

3.3 Data Consistency

If related or identical data is stored in multiple places, inconsistencies may exist (for example, after restoring a
single component). The following table describes how consistency can be verified and how inconsistencies may

be repaired:

Table 13

Component/data store Check tool/method Detailed Description

SAP SCM/SAP APO / OLTP
system

See Best Practice document
Internal and External
Consistency for SAP APO
(3.x) / mySAP SCM (4.x/5.0)
(service.sap.com/~sapidb/
0110003587000022148420
03E)

SAP liveCache / SAP DB

N/A

See Best Practice document
Internal and External
Consistency for SAP APO
(3.x) / mySAP SCM (4.x/5.0)
(service.sap.com/~sapidb/
0110003587000022148420
03E)

N/A

For additional information see SAP Notes 572003 and 1723242.
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4 Management of SAP APO

SAP provides you with an infrastructure to help your technical support consultants and system administrators
effectively manage all SAP components and complete all tasks related to technical administration and operation.

For more information about the underlying technology, see SAP Library for SAP NetWeaver on SAP Help Portal at
help.sap.com/nw703, under |+ SAP NetWeaver » Administrator’s Guide » Technical Operations for SAP
NetWeaver I or help.sap.com/nw74, under [p SAP NetWeaver » System Administration and Maintenance
Information » Technical Operations for SAP NetWeaver 1.

4.1

Starting and Stopping

We recommend that you start the components in the following order; to stop, proceed in reverse order:

Table 14: Start and Stop Sequences and Tools

Software Component

Start and Stop Sequences and Tools

SCM Server 1 STARTSAP/STOPSAP (Unix) | N/A
(Only relevant for SAP as part SAPMMC (Windows)
of SCM)
SAP liveCache 2 LC10 See below
SAP ERP 4 STARTSAP/STOPSAP (Unix) | N/A
SAPMMC (Windows)
SAP NetWeaver Business 5 STARTSAP/STOPSAP (Unix) | N/A
Intelligence (BI) SAPMMC (Windows)
SAP NetWeaver Process 6 STARTSAP/STOPSAP (Unix) | N/A
Integration (P1) SAPMMC (Windows)
CIF 7 Start: Reports RSTRFCQ3 See below
and RSTRFCI3
Stop: Reports RSTRFCQ1
and RSTREFCI1
SAP SCM Optimizer 8 Establish network connection | No explicit start/stop, but
to SCM system only network connection to
SCM/APO system necessary
using transaction SM59. For
more information, see the
Installation Guide of the SAP
SCM optimizer.
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Software Component Start and Stop Sequences and Tools

Sequence Detailed Description

Internet Graphics Server 8 You can start/stop the N/A
(IGS) Windows IGS by using
services. On your Windows
desktop, choose |» Start »
Settings » Control Panel »
Services 1 (or

b Administrative Tools »
Services J). Scroll down and
choose | SAPIGS » Start/
Stop Service 1.

Even though SAP Net Weaver Pl and SAP SCM optimizer can be started independently from all other
components, we recommend that you start/stop the components in a certain sequence.

For more information about STARTSAP/STOPSAP and SAPMMC, see SAP Library for SAP NetWeaver on SAP Help
Portal at help.sap.com/nw703, under [r SAP NetWeaver » Administrator’s Guide » Technical Operations for SAP
NetWeaver 1 or help.sap.com/nw74, under [ SAP NetWeaver » System Administration Maintenance
Information » Technical Operations for SAP NetWeaver 1.

Starting and Stopping SAP liveCache

SAP liveCache should be started and stopped using transaction DBACOCKPIT.

Alternatives: Call the RSLVCSTART and RSLVCSTOP reports from within SAP, or by using SAPEVT at OS level; call
the START LIVECACHE and STOP LIVECACHE function modules from within SAP, or by using STARTREC at OS
level.

For more information about starting and stopping SAP liveCache, see SAP Library for SAP NetWeaver on SAP
Help Portal at help.sap.com/maxdb.

You can also start SAP liveCache with DBMCL T or DBMGUT, but this may cause a short dump, so start it with
DBACOCKPIT if possible.

Starting and Stopping CIF

1 Note

If you are using the SAP APO as addon-on for SAP ERP deployment option, the term SAP SCM system means
the SAP APO system.

To start the CIF queues of your SAP SCM system, use the following reports in SCM and all connected SAP
Systems (ERP or R/3).

For outbound queues, use report RSTRFCQ3. Enter the following values:
® Parameter QNAME: CF*

® Parameter DEST: <Name of logical system>

® Parameter FORCE: no entry required

® Parameter NO_ACT: no entry required

For inbound queues, use report RSTRFCI 3. Enter the following values:

® Parameter QNAME: CF*
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® Parameter FORCE: no entry required
® Parameter MAXLUW: no entry required
® Parameter NO_ACT: no entry required

To determine whether you are using inbound or outbound queues, execute transaction CFcC1 in the connected
SAP systems (ERP or R/3) and transaction /sapap0o/C2 in the SCM system.

If you are using outbound queues, you only need to start the outbound queues. If you are using inbound queues,
you have to start inbound and outbound queues.

To stop the queues, use the following reports in the SAP SCM system and all connected SAP systems (ERP or
R/3) according to the queue type you are using:

For outbound queues, use report RSTRFCQ1. Enter the following values:

® Parameter QNAME: CE*

® Parameter DEST: <Name of Logical System of receiving system>
® Parameter FORCE: no entry required

For inbound queues, use report RSTRFCI1. For parameter QNAME, enter CE*. No entry is required for parameter
FORCE.

To determine whether you are using inbound or outbound queues, execute transaction CFcC1 in the connected
SAP systems (ERP or R/3) and transaction /saPAPO/C2 in the SCM system.

If you are using outbound queues, you only need to stop the outbound queues. If you are using inbound queues,
you have to stop inbound and outbound queues.

4.2 Software Configuration

This section explains which components or scenarios used by this application can be configured, and which tools
are available for adjusting them.

Table 15: Component Configuration Tools

Configuration Tool(s) Detailed Description

SAP SCM / SAP APO ABAP TAs: N/A
not CIF-specific SM59 Create RFC destination
BD54 Maintain logical systems
SMQR/SMQS gRFC queue registration
SMQ1/SMQ2 gRFC queue monitors
SBGRFCMON bgRFC queue monitor
SBGRFCCONF bgRFC configuration
SAP SCM / SAP APO ABAP TAs: N/A
Core Interface (CIF) /SAPAPO/C1 Business system group (BSG)
PUBLIC
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Configuration Tool(s) Detailed Description

/SAPAPO/C2 Assignment of BSG to logical system and specification
of the release, queue type, and error handling method
of the connected SAP system

/SAPAPO/C3 CIF application log

/SAPAPO/C4 Special user settings during CIF transfer

/SAPAPO/C91 Activation/deactivation of bgRFC in CIF

SAP ERP (CIF-specific) ABAP TAs: N/A

NDV2 Specification of connected system type and release

CFC1 Logical system — queue type assignment

CFC2 Special user settings during CIF transfer

CFC3 Filter size/select size adjustment

CFG1 CIF application log

SCM Basis not relevant No technical configuration data (see other applications
using SCM Basis, and the SCM Optimizer)
SCM Optimizer ABAP TA SM59 No technical configuration data

(all technical details are stored in standard ABAP
Customizing, for example transactions

SM59: RFC connectivity information

ABAP TARCC _CUST

(or RCC* respectively)

RCC_CUST: Defining and checking optimizer RFC
destinations — can also be used to check if optimizer
server is online)

RCC_SESSION Active Session
RCC_LOG Log Display
RCC_PARAM Settings for Experts

/SAPAPO/OPT10 Optimizer internal settings

Table 16: CIF-Specific Configuration Tools in ERP

Configuration Tool(s) Detailed Description

SAP ERP
(CIF-specific)

ABAP TAs: N/A

NDV2 Specification of connected system type and release
CFC1 Logical system — queue type assignment

CFC2 Special user settings during CIF transfer

CFC3 Filter size/select size adjustment

CFG1 CIF application log
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4.3 Administration Tools

SAP APO mainly uses standard administration tools based in SAP NetWeaver. For more information, see SAP
Library for SAP NetWeaver on SAP Help Portal at help.sap.com/nw703, under |» SAP NetWeaver » SAP
NetWeaver by Key Capability » Application Platform by Key Capability » ABAP Technology » Administration of
Application Server ABAP 3 or help.sap.com/nw74, under [ SAP NetWeaver » SAP NetWeaver Library: Function-
Oriented View » Application Server » Application Server ABAP » Administration of Application Server ABAP 1.

For managing other software components, see below and the solution operation guides listed in Related
Information [page 66].

4.3.1 SAPAPO

For more information about internal and external consistency for SAP APO, see the following Best Practice
document: Internal and external consistency for SAP APO 3.x and mySAP SCM 4.x / 5.0 (service.sap.com/
~sapidb/011000358700002214842003E).

For more information about performance monitoring in SCM 7.0 (including EHP2), see SAP Library for SAP
Advanced Planning and Optimization on SAP Help Portal at help.sap.com/scm703, under [p SAP Supply Chain
Management (SAP SCM) » SAP Advanced Planning and Optimization (SAP APO) » SAP APO Administration » APO
Performance Monitor 1.

Depending on the business processes you are using in SAP APO, you can find more information in the following
Best Practice documents:

®  Manage Demand Planning in SAP APO (3.x) / SAP SCM (4.x, 5.x) (service.sap.com/~sapidb/
011000358700000955412003E)

® Manage Supply Network Planning & CTM in SAP APO (3.x) and SAP SCM (4.x / 5.x)(service.sap.com/
~sapidb/011000358700004718192003E)

® Manage Production Planning in SAP APO (3.x) / mySAP SCM (4.x, 5.0)
(service.sap.com/~sapidb/011000358700008416512001E)

® Manage Global ATP in SAP APO (3.x) / SAP SCM (4.x /5.0 / 5.1)
(service.sap.com/~sapidb/011000358700007382482002E)

® Manage the Transportation Management Solution (TP/VS) in SAP APO (3.x) / SAP SCM (4.x/5.x
(service.sap.com/~sapidb/011000358700007382622002E)

4.3.2 SAP liveCache Technology

General Information

For up-to-date information about important SAP liveCache parameters, see SAP Note 719652. This note is
updated frequently.

Changes in the hardware configuration of your SAP liveCache machine, such as additional RAM or CPUs, or
changes in application data volumes or configuration may require different parameter settings. Check the above
note regularly for updated parameter settings. If you experience performance issues, check your SAP liveCache
settings against the latest recommendations in this note.
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Some important parameters for SAP liveCache are the following:
e MAXCPU
The number of CPUs that can be used by SAP liveCache. For information about load balancing of SAP
liveCache, see SAP Note 695721.
® CACHE SIZE

The size of the data cache memory area used by SAP liveCache. The initial value for this parameter is defined
during the sizing of your system. It may, however, require some tuning for normal operation, or in other
situations, such as increasing the amount of RAM or data volume on your SAP liveCache server.

e OMS HEAP LIMIT

The maximum usable heap memory of SAP liveCache and LCA routines (private memory)

1 Note
Changes to SAP liveCache parameters do not take effect until the SAP liveCache has been stopped and
restarted, so schedule downtime for SAP liveCache if you want to adjust any parameters.

SAP liveCache Memory Areas

This section describes the main SAP liveCache memory areas. These areas are: LC management, heap memory,
and net memory usage.

liveCache

1 LC Management

Parameter
OMS_HEAP_LIMIT
Heap Memory
z
5
£
U
=
=
ﬁ 'y Parameter
CACHE_SIZE

Figure 3

e | C management is needed for administrative purposes, such as starting, stopping, and backup of SAP
liveCache.

® Heap memory refers to the memory allocation of the LCA routines in SAP liveCache (private liveCache
memory regions).

©  Kernel parameter
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OMS HEAP LIMIT
® Net memory usage of objects is where the actual data is stored in SAP liveCache.
o Kernel parameter

CACHE_SIZE

Parameter OMS_HEAP_LIMIT

SAP Note 337445 describes how to perform the calculation and to adjust the parameter oMS HEAP LIMIT.

Monitoring Heap Memory Usage

LC heap memory allocation can be monitored using the internal SAP liveCache table OMS HEAP STATISTICS.
To read this data, we recommend using transaction DBACOCKPIT or a database tool such as Database Studio.

To monitor heap memory usage in the SAP liveCache Assistant, call transaction .c10 and choose |+ liveCache:
Monitoring » Current Status » Memory Areas » Heap Usage 1.

In this section, you can find the total heap area currently in use by SAP liveCache and LCA routines in the row
Maximum Heap Usage. You can also use the sum button to calculate the accumulated heap values. Here the row
Size is the memory that was allocated from the operating system. It reflects the Maximum segment size that was
needed by LCA routines since start of SAP liveCache.

Note that the sum of Size and the value of Maximum Heap Usage always differ slightly. In row Currently used the
current usage of memory by LCA routines and copied OMS objects is displayed. If the value of Size comes close to
the value of oMS HEAP LIMIT, errorsin LCA routines may occur due to insufficient memory.

When using DBMCLI, you can display heap memory by entering the command show storage.

For more information about using DBMCLI for displaying database information, see SAP Library for SAP
NetWeaver on SAP Help Portal at help.sap.com/maxdb under Database Manager CLI.

Heap memory is graphically represented below and consists of the following main building blocks:
® Total heap (kilobytes) — total heap area currently in use by SAP liveCache and LCA routines
e Reserved heap (kilobytes) — “high water” mark, maximum amount of heap used since SAP liveCache start

® Emergency heap (kilobytes) — reserved memory

EMERG_CHUNK_SIZE (E)

USED_BY_OMS_MALLOC (O)
/ Reserved (R)

A
A 4
A
A 4

TOTAL HEAP USAGE (Total

Hogn)
™

A 4

ntly used by LCA ol at Availabl
Was

ing copy of data ob

A
A4

Parameter OMS_HEAP_LIMIT

Figure 4
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Garbage Collectors and Data Cache Filling Levels

When you monitor the data cache usage or filling level, you see the value in the data cache usage percentage
column increase, then some time later decrease, considerably. This is because of the history data (OMS_HISTORY)
that is used for consistent views within SAP liveCache. This history data is only required for open transactions or
transactional simulations within SAP liveCache. When it is no longer required, the data is automatically deleted.
The garbage collectors are responsible for deleting this obsolete history data.

For more information about garbage collectors, see SAP Library for SAP NetWeaver on SAP Help Portal at

help.sap.com/maxdb under Database Manager CLI.

For an example of data cache usage call transaction DBACOCKPIT, then choose [ Memory Areas » Caches 1.

Cache Accesses

C sful Unsucces Hit Rate

Entire Data Cache 67.142.399 BE.347.998 794,401 98,82%
Histarlndo 2.271.992 2371.992 a 100,00%
OME Data 43,889,245 4313718 761328 98,29%
SQL Data 200981161 20.838.088 43073 98,79%
Catalog Cache G659, 262 5022678 1.636.501 T5,42%
Sequence Cache 5.079 5078 1 99,95%

Figure 5

For information about the operating system parameterization of SAP liveCache, see SAP Note 487972.

Table 17: Monitoring SAP liveCache Memory Areas and Data Volumes

Monitoring Object | Monitor Monitor Indicator or Error | Monitoring Responsibility
Transaction / Tool | Frequency Activity or Error
Handling
Procedure
Memory of SAP DBACOCKPIT, N/A Add RAM to To process LCA System monitoring
liveCache server then server, check data | routines, SAP team
(Windows only) |» Diagnosics » cache/cache size | liveCache uses
Problem Analysis ¥ and oms heap limit | heap memory.
Messages » Kernel parameters You need to limit
Messages 3, then this heap memory
search for string using SAP
Total physical liveCache
memory parameter
OMS_HEAP SIZE
Check that the
sum of
OMS_HEAP SIZE
and
data cache si
ze isno larger
than the main
memory of
machine.
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Monitoring Object

Monitor
Transaction / Tool

Monitor
Frequency

Indicator or Error

Monitoring
Activity or Error
Handling
Procedure

Responsibility

Current data cache | DBACOCKPIT, At least daily Check that there is | Size of data cache | System monitoring
size then |» Space » enough memory — actual sizein team
Caches 3 allocated for data | MB/KB
cache. See also -
DataCache filling
levels and active
parameters
Data cache filling DBACOCKPIT, At least daily If filling level Amount of total System monitoring
levels then [ Space » consistently above | DataCache used team
Caches 3 80%, check % of | by real data — see
OMS history v line OMS_DATA
OMS data. size
Consider resizing
CacheMemoryS
ize.
Data cache hitrate | DBACOCKPIT, At least daily Check that there is | This value should | System monitoring
then |+ Space ¥ enough memory be >=98.8% team
Caches 3 allocated fordata | |t it is not, your
cache. SAP liveCache
may be too small
orincorrectly
configured.
After restarting
SAP liveCache,
you need at least
50 000 SAP
liveCache data
requests before a
meaningful value is
shown.
Active SAP DBACOCKPIT, As required Adjust as Show currently Basis Support
liveCache then necessary. active parameters.
parameters b Administration » Parameter
OmsMaxHeapSiz | Parameters 3 OMS HEAP LIMI
e T B B
For parameter
settings and
calculation, see
SAP Notes 337445
and 719652.
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Monitoring Object

Monitor
Transaction / Tool

Monitor
Frequency

Indicator or Error

Monitoring
Activity or Error
Handling
Procedure

Responsibility

Heap memory
usage

DBACOCKPIT, then
|+ Space ¥ OMS
Heap Usage 3

Often (especially
when data
volumes or system
changes occur)

Sufficient memory
must be available
for heap areas,
data cache, and
the operating
system of the SAP
liveCache server —
and correctly
distributed
between them.

The list header
shows the value
for the reserved
memory marked
with Maximum
Heap Usage.

This value shows
the (private)
memory
dynamically
requested by SAP
liveCache, usually
for use by LCA
routines. It is not
returned to the OS
until SAP
liveCache is
stopped.

So this value
specifies the
amount of RAM
that is locked into
the SAP
liveCache/LCA
routines process -
it is reusable only
by SAP liveCache,
butitis not
necessarily
currently in use by
SAP liveCache; it is
the “high water”
mark of heap
usage.

System monitoring
team

Status, size, and
number of the data
area

Check filling level
of SAP liveCache
data area

DABCOCKPIT, then
|+ Space »
Caches 1

Daily

SAP Advanced Planning and Optimization 7.0 Including Enhancement Package 3

Management of SAP APO

If filling level is
higher than 80%,
consider adding a
new data volume
to avoid
bottlenecks.

The filling level
may reduce itself
automatically if

Check status and
that there is
enough data area
configured.

Check filling level
of SAP liveCache
data area carefully
to prevent SAP
liveCache

System monitoring
team
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Monitoring Object | Monitor

Transaction / Tool

Monitor
Frequency

Indicator or Error

Monitoring
Activity or Error
Handling
Procedure

Responsibility

the garbage
collector deletes
history data.

problems (not only
performance
issues; some
history data could
also be deleted,
leading to errors
with transactions).

Adding a data
volume

DABCOCKPIT, then
b Space » Data
Area 1

As necessary

Add data volume if
filling level of data
area is >=80%

Add data volume
as required.

Basis Support

Check filling level | DABCOCKPIT, then | Daily If filling level is Check filling level | System monitoring
of SAP liveCache | |» Space » Log higher than 50%, | of SAP liveCache | team
log area Area 3 consider log area carefully
activating to prevent SAP
automatic log liveCache
backups. problems.
Activating See SAP Help If necessary Activate Activate automatic | Basis Support
automatic log Portal at automatic log log backup if
backup help.sap.com/ backup if filling required.
maxdb under level of log area is
Backing Up >=50%
Database
SAP liveCache /SAPAPO/OM11 Daily Traffic lights: The reported System monitoring
action log e Red=errors | actionsare: team
or failures ® |nitializations
e Yellow= (Calls of
warnings program /
o  Green= SAPAPO/
SUCCESS DELETE LC
) ANCHORS)
Investigate errors -
and warnings. ®  Deletion of
old
(obsolete)
transactional
simulations
® Consistency
checks and
corrections
with /
SAPAPO/
OoM17
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Monitoring Object | Monitor Monitor Indicator or Error | Monitoring Responsibility
Transaction / Tool | Frequency Activity or Error

Handling

Procedure

e Creation,
change, and
deletion of
planning
versions

® FErrorsraised
by
transaction /
SAPAPO/
OM13

® Errorsraised
by program /
SAPAPO/
OM_REORG
DAILY (see
section SAP
APO
[page 54])

®  Activation
and deletion
of ATP time
series

® Changesin
SAP
liveCache

Customizing

You can automate SAP liveCache database management in the CCMS. The central DBA Planning Calendar is one
of the tools that you can use to automate actions. This calendar enables you to manage data and log backups as
well as update optimizer statistics and check the database structure in integrated SAP environments from a
central location.

For more information, see SAP Library for SAP NetWeaver on SAP Help Portal at help.sap.com/maxdb under DBA
Planning Calendar.

4.3.3 SAP SCM Optimizer

General Information
Transport of configuration settings

All configuration settings of the SCM Optimizer are stored on the application server. So normal ABAP transports
or customizing can be used for the transport of configuration settings.
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Customer modifications

The different optimizers cannot be changed by the customer. If customer-specific changes have been approved
by SAP, these are incorporated into the standard optimizer engines. Therefore, no special version management is
required. For changes outside the SCM Optimizer (ABAP), the workbench can be used.

Conflicts between customer-specific changes (ABAP) and SAP updates can be solved using the workbench.

Table 18: Monitoring SAP SCM Optimizer

Monitoring Object | Monitor

Transaction /

Tool

Monitor
Frequency

Indicator or Error

Monitoring
Activity or Error
Handling
Procedure

Responsibility

check if optimizer
server is online

Optimizer server rcc_cust During installation, | N/A Maintain master Basis Support
settings or for data for
configuration optimization
changes to servers.
optimizer servers
RFC destinations SM59 / During installation | Test connection Defining and System monitoring
for optimizers rcc_cust or after status to ensure all | checking optimizer | team and Basis
configuration is OK RFC destinations — | Support
changes can also be used to

See also SAP SCM Optimizer Analysis Tools [page 29].

4.4 Backup and Restore

You need to back up your system landscape regularly to ensure that you can restore and recover it in case of

failure.

The backup and restore strategy for SAP APO consists of two parts, as follows:

e Backup and restore coverage for each component (see table below)

® (Cross-system data dependencies and handling

The backup and restore strategy for your system landscape should not only consider SAP systems but should
also be embedded in overall business requirements and incorporate your company’s entire process flow.

In addition, the backup and restore strategy must cover disaster recovery processes, such as the loss of a data
center through fire. It is most important in this context that you ensure that backup devices are not lost together
with normal data storage (separation of storage locations).

Based on the type of application data contained in a component, we have introduced a categorization scheme for
system components that can be used to analyze the backup requirements of any system component and to easily
determine an appropriate backup method for this component.

The following table lists the categories in general, the table after this one lists the components used by SAP APO.
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Table 19

Categories of System

Components

Category Properties

Suggested Methods for
Backup and Restore

Examples

| Only software, no ®  No backup, new BDOC modeler
configuration or application installation in case of a
data recovery or
® |nitial software backup
after installation and
upgrade
®  Backup of log files
I Only software and ®  Backup after changes SAP Gateway

configuration information, no
application data

have been applied or

®  No backup, new
installation and
configuration in case of
arecovery

®  Backup of log files

Comm. Station
SAP Business Connector

SAPIPC (2.0C)

Only replicated application
data, replication time is
sufficiently small for a
recovery

Data:
®  No data backup needed

®  Backup of software,
configuration, log files

SAP IMS/Search Engine
SAPIPC (2.0B)
Webserver

SAPITS

IV Only replicated application Data: SAP IMS/Search Engine
data, backup recommended | o Application-specific file | Webserver
because replication time is system backup or
too long, data not d o

oolone, datanotmanage ®  Multiple instances
by a DBMS
®  Backup of software,
configuration, log files

Vv Only replicated application Data: SAPIPC (2.0B)
data, backup recommended | o  Database and log Catalog Server
because replication time is backup or
too long, dat db o

oolong, datamanaged by a ®  Multiple instances
DBMS
®  Backup of software,
configuration, log files

VI Original application data, Data: Webserver
standalone system, data not e Application-specific file
managed by a DBMS system backup

®  Backup of software,
configuration, log files

VI Original application data, Data: N/A

standalone system, data
managed by a DBMS, not
based on SAP WebAS

SAP Advanced Planning and Optimization 7.0 Including Enhancement Package 3
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® Database and log
backup
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Categories of System

Category Properties

Suggested Methods for

Components Backup and Restore
®  Backup of software,
configuration, log files
VI Original application data, Data: Standalone SAP ERP
standalone system, basedon | ¢  patapase and log
SAP WebAS backup, application log
backup (such as job
logs in file system)
®  Backup of software,
configuration, log files
IX Original application data, Data: N/A
data exchange with other ° Application—specific file
systems, data not managed system backup, data
by a DBMS consistency with other
systems must be
considered
®  Backup of software,
configuration, log files
X Original application data, Data: SAP liveCache
data exchange with other e Database and log SAP Mobile
t , dat db
systems, data managed by a backup, data Workbench
DBMS, not based on SAP consistency with other
WebAS systems must be
considered
e Backup of software,
configuration, log files
Xl Original application data, Data: SAP ERP
data exchange with other e Database and log SAP CRM
systems, based on SAP backup, applicationlog | sap sCM
WebAS back-up-(such as job SAP BW
logs in file system), data
consistency with other
systems must be
considered
e Backup of software,
configuration, log files

The following table lists the components used by SAP APO and how to backup them:

Table 20

Component

SAP SCM Server
(Category XI)

PUBLIC

Original application
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data (where data is

© Copyright 2015 SAP SE or an SAP affiliate company.

48 All rights reserved.

Data to Be Backed Up | Backup Method / Tool | Recommended

Backup Frequency

Backup Sequence (if

required)

Application data: SAP | N/A

recommendation:
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Component

Data to Be Backed Up

exchanged with other
systems; based on
Web AS), application
log data

Software,
configuration data, log
data

Backup Method 7/ Tool

® Database and log
backup,
application log
backup (such as
job logs in file
system), data
consistency with
other systems
must be
considered

e  Backup of
software,
configuration, log

Recommended

Backup Frequency

daily; redo log files
periodically (for
example, hourly)

Log/configuration files
on file system level:
once a week full
backup, daily
incremental backup

Software: SAP
recommendation: after
installation and before
and after each
software change such

Backup Sequence (if
required)

files as patches and
upgrades
SAP SCM Basis Original application Data: Application data: SAP | N/A
(Category Xl) data (where data is e Database and log recommendation:
exchanged with other backup, daily; redo log files
systems; based on application log periodically (for
Web AS), application backup (such as example, hourly)
log data job logs in file Log/configuration files
Software, system), data on file system level:
configuration data, log consistency with | once a week full
data other systems backup, daily
must be incremental backup
considered Software: SAP
®  Backup of recommendation: after
software, installation and before
configuration, log | and after each
files software change such
as patches and
upgrades
SAP liveCache Original application Data: Application data: SAP | N/A
(Category X) data (where data is e -MaxDB recommendation:

exchanged with other
systems; managed by
a DBMS, not based on
Web AS), application
log data

Software,
configuration data, log
data

database and log
backup, data
consistency with
other systems
must be
considered -

®  Backup of
software,
configuration, log
files

SAP Advanced Planning and Optimization 7.0 Including Enhancement Package 3
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daily; redo log files
periodically (for
example, hourly)

Log/configuration files
on file system level:
once a week full
backup, daily
incremental backup

Software: SAP
recommendation: after
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Component Data to Be Backed Up | Backup Method / Tool | Recommended Backup Sequence (if
Backup Frequency required)
installation and before
and after each
software change such
as patches and
upgrades

SAP SCM Optimizer (no persistent Data:- Software, N/A

(Category II) application data) Software configuration:

Software, configuration: On aregular basis, at
configuration data e Filesystem least after installation
backup either full | @nd software
orincremental; | UPgrades/
registry backup configuration changes
on Windows
platforms
or
®  No backup, new
installation and
configuration in
case of arecovery

SAP Internet Graphics | -- (no persistent Data: - Software, N/A

Service (IGS) application data) Software configuration:

(Category II) Software, configuration: On aregular basis, at

configuration data e Filesystem least after installation
backup either full | and software
or incremental upgrades /
configuration changes
SAP ERP Original application Data: Application data: SAP | N/A

(Category Xl)

data, data exchange
with other systems,
based on SAP Web AS

Software,
configuration data, log
data

® Database and log
backup,
application log
backup (such as
job logs in file
system), data
consistency with
other systems
must be
considered

®  Backup of
software,
configuration, log
files

recommendation:
daily; redo log files
periodically (for
example hourly)

Log/configuration files
on file system level:
once a week full
backup, daily
incremental backup

Software: SAP
recommendation: after
installation and before
and after each
software change like
patches and upgrades
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Component Data to Be Backed Up | Backup Method / Tool | Recommended Backup Sequence (if
Backup Frequency required)

SAP NetWeaver See SAP Library for SAP NetWeaver on SAP Help Portal at help.sap.com/nw703, under |» SAP
(Usage Type PI) NetWeaver » Administrator's Guide » Technical Operations for SAP NetWeaver » Administration
of SAP NetWeaver Systems » Pl (Process Integration) » Management » Backup/Restore and
Recovery dor help.sap.com/nw74, under [ SAP NetWeaver » System Administration and
Maintenance Information ¥ Technical Operations for SAP NetWeaver » Administration of Pl
(Process Integration) » Management » Backup/Restore and Recovery 3.

SAP NetWeaver See SAP Library for SAP NetWeaver on SAP Help Portal at help.sap.com/nw703, under [ SAP
(Usage Type BI) NetWeaver » Administrator's Guide » Technical Operations Manual for SAP NetWeaver »
Administration of SAP NetWeaver Systems ¥ Bl (Business Intelligence) ¥ Backup and Recovery (AS
ABAP) Jor help.sap.com/nw74, under [F SAP NetWeaver » SAP NetWeaver Library: Function-
Oriented View » Solution Lifecycle Management ¥ Backup and Recovery 1.

SAP cFolders See SAP Library for SAP NetWeaver on SAP Help Portal at help.sap.com/nw703, under [+ SAP
NetWeaver » SAP NetWeaver by Key Capability » Application Platform by Key Capability » ABAP
Technology » Administration of Application Server ABAP 1 or help.sap.com/nw74, under |+ SAP
NetWeaver » SAP NetWeaver Library: Function-Oriented View » Application Server » Application
Server ABAP » Administration of Application Server ABAP 1.

1 Note

The backup of database and Web AS takes care of application data, configuration settings and log data. For
more information, see Best Practice document Backup and Restore for mySAP Business Suiteon
SAP Service Marketplace at |» service.sap.com/bp-roadmap » Operations Implementation 3.

Frequency of the Backup
SAP ERP

SAP ERP recommends that you back up your individual components in the SAP ERP 6.0 landscape regularly to
ensure that you can restore and recover them if there is a system failure. For more information about backup and
recovery for SAP ERP 6.0, see SAP Service Marketplace atlp service.sap.com/instguides » SAP Business Suite
Applications » SAP ERP » SAP ERP 6.0 » Operations 3 and also SAP enhancement packages for SAP ERP 6.0.

Backup Procedures

SAP APOQ is based on SAP NetWeaver (Web Application Server ABAP) technology. All backup procedures for
ABAP-based components also work for SAP APO. For more information about backup and recovery, see SAP
Library for SAP NetWeaver on SAP Help Portal at help.sap.com/nw703, under [ SAP NetWeaver » SAP
NetWeaver by Key Capability » Application Platform by Key Capability » ABAP Technology » Administration of
Application Server ABAP 3 or help.sap.com/nw74 , under [ SAP NetWeaver » SAP NetWeaver Library: Function-
Oriented View » Application Server » Application Server ABAP » Administration of Application Server ABAP 1.

Online Backup

The data contained in the database can be backed up online; however, it is not possible to do the same for the
runtime infrastructure. An online backup refers to the system landscape and not the databases that contain the
business-critical application, or the infrastructure components.
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1 Note

If you perform a backup while the server is running, open files may not be backed up.

Backup and Recovery of SAP NetWeaver Components

For more information about backup and restore for the usage type Application Server for ABAP, usage type
Process Integration (PI), and the usage type Business Intelligence (BI), see SAP Library for SAP NetWeaver on
SAP Help Portal at help.sap.com/nw703, under |» SAP NetWeaver » Administrator’s Guide » Technical Operations
for SAP NetWeaver » Administration of SAP NetWeaver Systems 3 or help.sap.com/nw74, under [ SAP
NetWeaver » Sytem Administration and Maintenance Information » Technical Operations for SAP NetWeaver »
Administration of SAP NetWeaver Systems 1.

Backup and Recovery for SAP SCM Basis

For information, see Application Operations Guide for Supply Chain Management 7.0 including SAP enhancement
package 3 in SAP Service Marketplace at service.sap.com/instguides, under [ SAP Business Suite Applications »
SAP SCM » SAP SCM Server » Using SAP Enhancement Package 3 for SAP SCM 7.0 1.

Backup and Recovery for SAP SCM Server, SAP liveCache technology, and SAP SCM Optimizer

For specific information about backup/restoration and recovery ofSAP Advanced Planning and Optimization as
well as the SAP SCM Optimizer, see the Best Practice document Backup and Restore for mySAP on SAP Service
Marketplace at |» service.sap.com/bp-roadmap » Operations Implementation » Backup and Restore for mySAP
Business Suite 3 and the Best Practice Backup, Recovery and High Availability for SAP APO (3.x) / mySAP SCM
(4.x).

For information about backup and recovery of SAP liveCache, see the Checklist for Recovery of SAP liveCache.

The SAP SCM Optimizer does not contain any persistent application data. Therefore, no backup is required.
Perform a new installation in case of a restore.

Backup and Recovery for SAP Internet Graphics Server (IGS):
The SAP IGS does not contain any persistent application data. Therefore, you only need to back up the IGS itself
and the configuration files.
Depending on where the IGS is installed, you have the following options for backup and recovery:
1. Installation on Web AS
If you have installed the IGS on the Web AS, you have two options for backup and recovery, as follows:

1. Make a backup of all files of the IGS installation using operating system tools. You can recover the IGS by
using your backup.

2. Make a backup of all files in the conf directory of the IGS installation. For a recovery, reinstall the IGS and
copy all files from the conf directory back to the conf directory.

2. Standalone Installation on Microsoft Windows Server
If you have installed the IGS on a standalone Microsoft Windows server, you have two options for backup and
recovery, as follows:
1. Make a backup of all files of the IGS installation. For a recovery, restore the IGS files and restart the IGS
service in Microsoft Windows using command igswdserv -i inthe bin directory of the installation
directory.

2. Make a backup of all files in the conf directory of the IGS installation. For a recovery, reinstall the IGS and
copy all files from the conf directory back to the conf directory.
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4.5 Application Copy

Homogeneous System Copy

If you are using SAP APO (including SAP liveCache), you can find information about a homogeneous system copy
(that is, without changing your operating system or database platform) in the SAP System Landscape Copy for
SAP NetWeaver and mySAP Solutions document at | service.sap.com/scm » Technology » SAP System
Landscape Copy for SAP NetWeaver and mySAP Solutions 2 and SAP Notes 210564 and 129352.

For a homogeneous system copy of SAP SCM Optimizer, the standard procedures of SAP NetWeaver apply.

For more information, see SAP Library for SAP NetWeaver on SAP Help Portal at help.sap.com/nw703, under
I SAP NetWeaver » Administrator’s Guide » Technical Operations for SAP NetWeaver 3 or help.sap.com/nw74,
under |» SAP NetWeaver » System Administration and Maintenance Information » Technical Operations for SAP
NetWeaver 1.

You should be aware that the Multiple Output Planning scenario uses characteristics-dependent planning (CDP).
The master data for characteristic propagation is maintained in the production process model (PPM). After every
client copy, system copy, or an upgrade, the characteristic propagation of the PPMs has to be generated again.
For more information, see SAP Note 494839.

Heterogeneous System Copy

Heterogeneous system copies for SAP APO are currently supported on request and on a project basis. For more
information, see SAP Note 543715. More details and forms are available under service.sap.com/osdbmigration.

1 Note

A client copy from one system into another system with a different operating system or database is not an
alternative to a complete heterogeneous migration. For example, client copies do not ensure that all repository
changes are taken over into the new system. Therefore, if you want to change your SAP APO database or
application server platform, a heterogeneous system copy is the only procedure that ensures full data
replication into the new system.

For more information about a heterogeneous system copy of SAP liveCache, see SAP Note 632357.

1 Note

After a system copy, the connections between the systems as well as the system identifiers in the business
configuration of the SAP NetWeaver Pl system must be corrected to reflect the copies instead of the original
systems.

4.6 Periodic Tasks

4.6.1 Scheduled Periodic Tasks

This section describes all automatable tasks required to run periodically to keep the application running smoothly
over time. Such tasks may be required on component level and are therefore relevant in each scenario that uses
the component. You can find the mapping in the Scenario/Component Matrix [page 10] section above. Other
tasks may be relevant for certain business scenarios only. It is important that you monitor the successful
execution of these tasks on a regular basis.
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In addition to the standard jobs mentioned in the Technical Operations Manual for SAP NetWeaver (in SAP Library
under SAP NetWeaver), you must schedule APO-specific jobs in your APO system and, where specified, in all the
connected SAP systems.

Alljobs, unless otherwise specified, should be run at times of minimal system activity, so as not to affect
performance or otherwise disrupt your daily operations.

4.6.11 SAP SCM Basis (Part of SCM Server)

For information, see Application Operations Guide for Supply Chain Management 7.0 including SAP enhancement
package 3 in SAP Service Marketplace at service.sap.com/instguides, under [ SAP Business Suite Applications
SAP SCM » SAP SCM Server » Using SAP Enhancement Package 3 for SAP SCM 7.0 1.

4.6.1.2 SAP APO

Table 21: Standard/Housekeeping Jobs

Program Name / Task Recommended Detailed Description Responsibility
Frequency

Report BRCONNECT Daily Calculates BW-relevant optimizer Basis Job Scheduling
statistics (for Oracle); see SAP Notes
129252 and 421795.
Report /SAPAPO/ Weekly / Monthly Extends time streams of resources in Application Support / Job
CRES_CAPACITY_ LENG SAP liveCache. Scheduling Team
THEN
Jobs for reorganization N/A You can select various jobs for reorganization from the SAP Easy Access

menu under |+ SAP Supply Chain Management » Advanced Planning and
Optimization » APO Administration » Reorganization 3

For more information about the particular jobs, see the Best Practice
documents mentioned below.

For more information about relevant jobs for SAP APO, see the Best Practice document Internal and external
consistency for SAP APO 3.x and mySAP SCM 4.x / 5.0 (service.sap.com/~sapidb/
011000358700002214842003E)

Depending on the business processes you are using in SAP APO, you can find more information in the following
Best Practice documents:

® Manage Demand Planning in SAP APO (3.x) / SAP SCM (4.x, 5.x) (service.sap.com/~sapidb/
011000358700000955412003E)

®  Manage Supply Network Planning & CTM in SAP APO (3.x) and SAP SCM (4.x /' 5.x) (service.sap.com/
~sapidb/011000358700004718192003E)

® Manage Production Planning in SAP APO (3.x) / mySAP SCM (4.x, 5.0)
(service.sap.com/~sapidb/011000358700008416512001E)
® Manage Global ATP in SAP APO (3.x) / SAP SCM (4.x /5.0 / 5.1)
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(service.sap.com/~sapidb/011000358700007382482002E)

® Manage the Transportation Management Solution (TP/VS) in SAP APO (3.x) / SAP SCM (4.x/5.x)
(service.sap.com/~sapidb/011000358700007382622002E)

4.6.1.3 SAP liveCache Technology

Program Name /
Task

Table 22: Standard/Housekeeping Jobs

Recommended

Frequency

Detailed Description

Responsibility

OM REORG DAILY

Transaction /

and old Optimizer logs. For more
information, see SAP Notes 139558 and
679118.

Report /SAPAPO/ Weekly / Monthly Extends time streams of resources in SAP | Application Support / Job
CRES_CAPACITY liveCache. scheduling team
LENGTHEN
Report Daily Starts a backup of SAP liveCache. Basis Job Scheduling
RSLVCBACKUP See SAP Note 455154 for the report
Transaction DB13C RSLVCBACKUP and SAP Library for SAP
(Central DBA NetWeaver on SAP Help Portal at
Planning calendar) help.sap.com/maxdb under DBA Planning

Calendar.
Report /SAPAPO/ Daily Deletes old transactional simulation data, | Basis Job Scheduling

LOGGING_LOG DE
L

SAP Advanced Planning and Optimization 7.0 Including Enhancement Package 3
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to a specific date.

SAPAPO/OM25
To check whether this job is scheduled,
use transaction /SAPAPO/OM13
|F Checks Jtab.
Report / Every 30 minutes Reorganizes LCA data from old sim Basis Job Scheduling
SAPAPO/OM sessions in SAP liveCache; helps free up
DELETE OLD memory
SIMSESS To check whether this job is scheduled,
use transaction /SAPAPO/OM13
[F Checks 2tab.
Report / Daily Provides Information for CCMS Basis Job Scheduling
SAPAPO/OM monitoring of SAP liveCache, see also
LCAALERTS SAP Note 683554).
To check whether this job is scheduled,
use transaction /SAPAPO/OM13
|» Checks Jtab page.
Report /SAPAPO/ Monthly or as Use to delete the SAP liveCache action log | Basis Job Scheduling
OM LC_ required (see /SAPAPO/OM11 insection 4.1.2) up
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Program Name / Recommended Detailed Description Responsibility

Task Frequency

Transaction /
SAPAPO/OM12

46.1.4 SAP SCM Optimizer

Table 23: Standard/Housekeeping Jobs

Program Name / Task Recommended Frequency Detailed Description

Report /SAPAPO/OM_REORG DAILY | Daily Deletes old LCA, transactional

Transaction /SAPAPO/OM25 simulation data, and old optimizer logs.
See SAP Notes 139558 and 679118.

4.6.1.5 Make to Order for OEM

1 Note

In an add-on deployment of APO, this feature is only supported as of support package 7 for SAP APO 7.0
EHP 3.

Table 24: Standard/Housekeeping Jobs

Program Name / Task Recommended Frequency Detailed Description

Transaction Monthly Deletes obsolete date vectors (pointers
RPM DATEVECTORS REORG between requirements and resources)

Report RPM_DATEVECTORS_REORG In SAP liveCache.

(Only relevant for SAP APO as part of

SAP SCM)
Report /SAPAPO/ Monthly Deletes obsolete PDS data in SAP
CULL DELETE_ RTO liveCache.

4.6.2 Required Manual Periodic Tasks

This section describes all manual tasks required to run periodically to keep the application running smoothly over
time. A manual task needs a person to execute it, in contrast to the scheduled tasks listed above, which can be
automated using a task scheduler program. Such tasks may be required on component level and are therefore
relevant in each scenario that uses the component. Other tasks may be relevant for certain business scenarios
only. Itis important that you monitor the successful execution of these tasks on a regular basis.
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4.6.21 SAP SCM Basis (Part of SCM Server)

For information, see Application Operations Guide for Supply Chain Management 7.0 including SAP enhancement
package 3 in SAP Service Marketplace at service.sap.com/instguides, under [F SAP Business Suite Applications »
SAP SCM » SAP SCM Server » Using SAP Enhancement Package 3 for SAP SCM 7.0 1.

4.6.2.2 SAP APO

For more information about required manual tasks for SAP APO, see the following Best Practice document:
Internal and external consistency for SAP APO 3.x and mySAP SCM 4.x / 5.0 (service.sap.com/~sapidb/
011000358700002214842003E).

Depending on the business processes you are using in SAP APO, you can find more information in the following
Best Practice documents:

®  Manage Demand Planning in SAP APO (3.x) / SAP SCM (4.x, 5.x) (service.sap.com/~sapidb/
011000358700000955412003E)

®  Manage Supply Network Planning & CTM in SAP APO (3.x) and SAP SCM (4.x / 5.x)(service.sap.com/
~sapidb/011000358700004718192003E)

®  Manage Production Planning in SAP APO (3.x) / mySAP SCM (4.x, 5.0)
(service.sap.com/~sapidb/011000358700008416512001E)

® Manage Global ATP in SAP APO (3.x) / SAP SCM (4.x /5.0 / 5.1)
(service.sap.com/~sapidb/011000358700007382482002E)

® Manage the Transportation Management Solution (TP/VS) in SAP APO (3.x) / SAP SCM (4.x/5.x
(service.sap.com/~sapidb/011000358700007382622002E)

The following table lists the business processes above and their location in the Solution Manager Content:

Table 25

Demand Planning and Forecasting IF SAP SCM » Scenarios » Demand and Supply Planning
Processes in SCM » Business Processes » Demand Planning
and Forecasting 2

Multilevel Demand & Supply Match IF SAP SCM » Scenarios » Demand and Supply Planning
Processes in SCM » Business Processes » Multilevel Demand
& Supply Match 2

Backorder Processing |» Sales » Business Processes }» Backorder Processing 3

4.6.2.3 SAP liveCache Technology

For information about required manual periodical tasks in SAP liveCache, see section SAP liveCache Technology
Analysis Tools [page 22], and the Best Practice document Internal and External Consistency for SAP APO 3.x /
mySAP SCM 4.x/5.0 (service.sap.com/~sapidb/011000358700002214842003E).
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4.6.2.4 SAP SCM Optimizer

For information about required manual periodical tasks in SAP SCM Optimizer, see section SAP SCM Optimizer
Analysis Tools [page 29].

For information about required manual periodical tasks in SAP liveCache, see section SAP liveCache Technology
Analysis Tools [page 22].

4.7 Load Balancing

SAP APO uses the standard functionality of SAP NetWeaver for logon and load balancing. For more information
about network load balancing, see SAP Service Marketplace at service.sap.com/ha and SAP Library for SAP
NetWeaver on SAP Help Portal at help.sap.com/nw703, under [» SAP NetWeaver » Administrator’s Guide »
Technical Operations for SAP NetWeaver 3 or help.sap.com/nw74, under |» SAP NetWeaver » System
Administration and Maintenance Information » Technical Operations for SAP NetWeaver 1.

4.8 User Management

SAP APO uses the standard functionality of SAP NetWeaver for user management, such as creating users with
transaction sU01 and creating and using roles with transaction PFCG.

For more information about user management in SAP APO, see the SAP APO Security Guide on the SAP Service
Marketplace atlp service.sap.com/securityguide » SAP Business Suite Applications » SAP SCM » SAP Advanced
Planning and Optimization » SAP APO Security Guide 1.

For an overview of the information necessary for operating SAP NetWeaver Identity Management, see SAP
Library for SAP NetWeaver on SAP Help Portal at help.sap.com/nw703, under |» SAP NetWeaver » SAP
NetWeaver by Key Capability » Security ¥ Identity Management 3 or help.sap.com/nw74, under [ SAP
NetWeaver » SAP NetWeaver Library: Function-Oriented View » Security ¥ Identity Management 1.

4.9 Printing

SAP APO uses the standard functionality of SAP NetWeaver for printing. For more information about printing, see
SAP Library for SAP NetWeaver on SAP Help Portal at help.sap.com/nw703, under |+ SAP NetWeaver » SAP
NetWeaver by Key Capability » Application Platform by Key Capability » ABAP Technology » Administration of
Application Server ABAP » SAP Printing Guide (BC-CCM-PRN) 3 or help.sap.com/nw74, under |» SAP

NetWeaver » SAP NetWeaver Library: Function-Oriented View » Application Server » Application Server ABAP »
Administration of Application Server ABAP » SAP Printing Guide (BC-CCM-PRN) 1.
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5 High Availability

For high availability options of SAP APO, SAP liveCache technology, and SAP SCM Optimizer, you can find
information in the Best Practice document Backup, Recovery and High Availability for SAP APO (3.x) / mySAP
SCM (4.x) (service.sap.com/~sapidb/011000358700007382632002E).

For high availability of all other components of SCM, see the information on SAP Service Marketplace at
service.sap.com/ha, or see SAP Library for SAP NetWeaver on SAP Help Portal at help.sap.com/703, under

| SAP NetWeaver » Administrator’s Guide » Technical Operations for SAP NetWeaver 3 or help.sap.com/nw74,
under |» SAP NetWeaver » System Administration and Maintenance Information » Technical Operations for SAP
NetWeaver 1.
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6 Software Change Management

Software Change Management standardizes and automates software distribution, maintenance, and testing
procedures for complex software landscapes and multiple software development platforms. These functions
support your project teams, development teams, and application support teams.

The goal of Software Change Management is to establish consistent, solution-wide change management that
allows for specific maintenance procedures, global rollouts (including localizations), and open integration with
third-party products.

This section provides additional information about the most important software components.
The following topics are covered:
® Transport and Change Management

Enables and secures the distribution of software changes from the development environment to the quality
assurance and production environment.

® Development Request and Development Release Management
Enables customer-specific maintenance procedures and open integration with third-party products.
® Template Management
Enables and secures the rollout of global templates, including localizations.
®  Quality Management and Test Management
Reduces the time, cost, and risk associated with software changes.
® Support Packages and SAP Notes Implementation
Provides standardized software distribution and maintenance procedures.
® Release and Upgrade Management

Reduces the time, cost, and risk associated with upgrades.

6.1 Transport and Change Management

For transport and change management issues, the procedures of SAP NetWeaver apply. For more information,
see the SAP Library for SAP NetWeaver on SAP Help Portal at help.sap.com/nw703, under [F SAP NetWeaver »
SAP NetWeaver by Key Capability » Application Platform by Key Capability » ABAP Technology » Administration of
Application Server ABAP » Change and Transport System 3 or help.sap.com/nw74, under |» SAP NetWeaver »
SAP NetWeaver Library: Function-Oriented View » Application Server » Application Server ABAP » Administration
of Application Server ABAP » Change and Transport System 1.

SCM Optimizer

The ABAP parts of the optimizers can be transported via standard ABAP transport and chance management. The
optimizer-engines themselves need to be copied manually (file system tree apoopt).
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6.2 Development Requests and Development Release
Management

The standard procedures of SAP NetWeaver apply. For more information, see SAP Library for SAP NetWeaver on
SAP Help Portal at help.sap.com/nw703, under |» SAP NetWeaver » Administrator's Guide » Technical
Operations for SAP NetWeaver 3 or help.sap.com/nw74, under |» SAP NetWeaver » System Administration and
Maintenance Information » Technical Operations for SAP NetWeaver 1.

For more information about customer-specific development, see SAP Library for SAP NetWeaver on SAP Help
Portal at help.sap.com/nw703, under [ SAP NetWeaver » SAP NetWeaver by Key Capability » Application
Platform by Key Capability » ABAP Technology » Administration of Application Server ABAP » Change and
Transport System » Change and Transport System - Overview » Changing the SAP Standard (BC) 2 or
help.sap.com/nw74, under |» SAP NetWeaver » SAP NetWeaver Library: Function-Oriented View » Application
Server » Application Server ABAP » Administration of Application Server ABAP » Change and Transport System »
Change and Transport System - Overview » Changing the SAP Standard (BC) 1.

6.3 Template Management

You can deploy Customizing settings by using Business Configuration Sets (BC sets).

For more information about BC sets, see BC Set Documentation.

6.4 Quality and Test Management

You can use the SAP NetWeaver Development Infrastructure to learn about the various possibilities to test your
software changes.

6.5 Support Packages and Patch Implementation

We recommend that you implement Support Package Stacks (SP-stacks), which are sets of support packages
and patches for the respective product version that must be used in the given combination. The technology for
applying support packages and patches does not change.

You can find detailed information about the availability of SP stacks for SAP APO on SAP Service Marketplace at
service.sap.com/sp-stacks.

Read the corresponding Release and Information Notes (RIN) before you apply any support packages or patches
of the selected SP Stack.

Use the Maintenance Optimizer (transaction bswp) of the SAP Solution Manager to select, download, and install
the needed usages, or software components and required support packages. For more information, see the
following:

®  SAP Solution Manager documentation on SAP Help Portal at |p help.sap.com » Application Lifecycle
Management » SAP Solution Manager » Maintenance Management » Maintenance Optimizer 3
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®  SAP Service Marketplace at service.sap.com/solman-mopz
® The documentation for transaction SATNT (SAP Add-On Installation Tool)

For more information about the implementation of support packages as well as possible side effects, see
| service.sap.com/patches » SAP Support Packages in Detail 3

For more information about the tools necessary for implementing patches, see the SAP Library for SAP
NetWeaver on SAP Help Portal at help.sap.com/nw703, under [» SAP NetWeaver » SAP NetWeaver by Key
Capability » Application Platform by Key Capability » ABAP Technology » Administration of Application Server
ABAP Jor help.sap.com/nw74, under | SAP NetWeaver » SAP NetWeaver Library: Function-Oriented View »
Application Server » Application Server ABAP » Administration of Application Server ABAP 1.

6.6 Release and Upgrade Management

For information about an upgrade, see the Upgrade Master Guide for SAP APO.

SAP delivers new functions through enhancement packages. With SAP enhancement packages, you can install
and activate new functions driven by your business needs without performing a system upgrade. The
enhancement package installation requires two different tools — SAP Solution Manager Maintenance Optimizer
and the Enhancement Package Installation tool.

As before, corrections are available in Support Packages. SAP provides Support Packages on a regular basis
during the defined maintenance period. In parallel, SAP provides equivalent Support Packages for enhancement
packages. You must install parts of the enhancement packages in combination with the latest available Support
Packages. This approach allows reducing installation, modification adjustment, and testing effort. Using this
strategy, SAP enhancement packages can be installed as a normal maintenance activity together with Support
Packages.

For more information about the release and upgrade management of SAP NetWeaver see SAP Library for SAP
NetWeaver on SAP Help Portal at help.sap.com/nw703, under [ SAP NetWeaver » Administrator’s Guide »
Technical Operations Manual for SAP NetWeaver » Administration of SAP NetWeaver Systems » Pl (Process
Integration) » Software Logistics » Release and Upgrade Management 3 or help.sap.com/nw74, under [» SAP
NetWeaver » System Administration and Maintenance Information » Technical Operations Manual for SAP
NetWeaver » Administration of Pl (Process Integration) » Software Logistics » Release and Upgrade
Management 1.

For all other components, see the application operation guides listed in section Related Information [page 66].

Table 26: Component Release

Software Component Tools for Displaying the Current Version

SCM APO or SAP SCM Menu |+ System » Status 3
SAP liveCache Transaction /SAPAPO/OM13
SAP ERP Menu |+ System » Status 3
CIF (Plugln) Menu |+ System » Status 3
SAP SCM Optimizer Transaction rcc_version
Xl See below
Internet Graphics Service (IGS) See below
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Software Component Tools for Displaying the Current Version

‘ SAP BI ‘ Menu | System » Status 3 ‘

Displaying the Support Package Version of IGS

You can display the Support Package version of the IGS in the following two ways:
® Using the Web Interface
http://<hostname>:<port>
<hostname> = The name of the machine where the IGS is installed, for example P12345
<port>= The port of the http listener. You can find this in the IGS configuration file.
® Using CCMS (see section CCMS Monitoring Installation and Setup [page 11])

For more information, see SAP Library for SAP NetWeaver on SAP Help Portal at help.sap.com/nw703,
under |+ SAP NetWeaver » SAP NetWeaver by Key Capability » Application Platform by Key Capability »
ABAP Technology » Ul Technologies in ABAP » Frontend Services (BC-FES) » SAP Graphics (BC-FES-GRA) »
Internet Graphics Service » Administering the IGS 3 or help.sap.com/nw74, under |» SAP NetWeaver » SAP
NetWeaver Library: Function-Oriented View » Application Server » Application Server ABAP » Ul Frameworks
Based on Application Server ABAP » Further Ul Technologies » SAP Graphics (BC-FES-GRA) » Internet
Graphics Service » Administering the IGS 1.

Displaying the Support Package Version of XI Content

For information, see Application Operations Guide for Supply Chain Management 7.0 including SAP enhancement
package 3 in SAP Service Marketplace at service.sap.com/instguides, under [k SAP Business Suite Applications ¥
SAP SCM » SAP SCM Server » Using SAP Enhancement Package 3 for SAP SCM 7.0 1.

SAP Release and Upgrade Plans

For information about SAP’s release and upgrade plans, see SAP Service Marketplace at |p service.sap.com/
releasestrategy » SAP Business Suite » SAP Supply Chain Management 3.

For information about the maintenance strategy and further services for SAP SCM, see service.sap.com/
maintenance.

You can access the upgrade guide at |p service.sap.com/instguides » SAP Business Suite Applications » SAP
SCM » SAP APO » Using SAP enhancement Package 3 for SAPAPO 7.0 1.

PUBLIC
SAP Advanced Planning and Optimization 7.0 Including Enhancement Package 3 © Copyright 2015 SAP SE or an SAP affiliate company.
Software Change Management All rights reserved. 63


http://help.sap.com/nw703
http://help.sap.com/nw74
http://service.sap.com/instguides
http://service.sap.com/releasestrategy
http://service.sap.com/releasestrategy
http://service.sap.com/maintenance
http://service.sap.com/maintenance
http://service.sap.com/instguides

7 Support Desk Management

Support Desk Management enables you to set up an efficient internal support desk for your support organization
that seamlessly integrates your users, internal support employees, partners, and SAP Active Global Support
specialists with an efficient problem resolution procedure.

For support desk management, you need the methodology, management procedures, and tools infrastructure to
run your internal support organization efficiently.

The following topics are covered:
® Remote Support
e Component hierarchy relevant for this application

SAP liveCache Assistant(transaction .€10) is an administration and support tool that is accessible in the Web
browser as well as in the SAP GUI. A read-only support role is available for using SAP liveCache Assistant. For
information about how to set up the role, see SAP Note 452745.

For more information about SAP liveCache Assistant, see SAP Library for SAP NetWeaver on SAP Help Portal at
help.sap.com/nw703, under [» SAP NetWeaver » SAP NetWeaver by Key Capability » Database Administration »
Database Administration for SAP MaxDB » Database Administration in CCMS: SAP MaxDB » Database
Administration in CCMS: SAP liveCache Technology ¥ liveCache Assistant 3 or help.sap.com/nw74, under |» SAP
NetWeaver » SAP NetWeaver Library: Function-Oriented View » Database Administration » Database
Administration for SAP MaxDB » Database Administration in CCMS: SAP MaxDB » Database Administration in
CCMS: SAP liveCache Technology » liveCache Assistant 1.

7.1 Remote Support Setup

SAP Support needs to be able to work remotely for highest efficiency and availability. Therefore, all required
support tools must be remotely accessible for SAP support. For SAP APO, the standard SAP procedures for
setting up remote support apply.

For information about Remote Support Setup, see SAP Service Marketplace at service.sap.com/access-support.

For the SAP SCM Optimizer the standard ERP support connection is normally sufficient. In very rare cases, the
support requires direct access to the optimization server via Windows Terminal Server / Telnet (depending on the
used operating system).

7.2 Problem Message Handover

For information about processing of internal support messages and forwarding them to SAP, see SAP Help Portal
at | help.sap.com » Application Lificycle Management » SAP Solution Manager » Service Desk 1.

For sending problem messages/tickets to SAP, choose the appropriate component (or subcomponent) name
from the SAP component hierarchy:
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Table 27
SCM Supply Chain Management
+ SCM-CA SCM Cross Applications
+ SCM-APO Advanced Planning and Optimization
+ SCM-APO-OPT SCM Optimizer
+SCM-BAS SCM Basis

The SCM Focus Group offers technical consulting services such as Administration, Monitoring, and Backup and
Recovery concepts for your APO system.

You can find a detailed list of the services, as well as all contact persons, in the SCM Focus Group fact sheet on
SAP Service Marketplace under [¢ service.sap.com/scm » SAP SCM Technology » Technical Consulting (in the
Related Topics box) » SCM Technology Focus Group 1.

For an overview of all services provided by SAP APO, see SAP Service Marketplace at service.sap.com/
safeguarding.
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A Appendix

A.l Appendix

A.l.l Related Guides

You can find more information about installation and configuration in the SAP APO Master Guide.

A.1l.2 Related Information

The following table contains links to information related to the Application Operations Guide.

Table 28
Content Quick Link on SAP Service Marketplace
Master Guide, Installation Guide and Upgrade Guide /instguides
Related SAP Notes /notes
Released Platforms /platforms
Network Security /securityguide
/network
Technical Infrastructure /installINW70
SAP Solution Manager /solutionmanager

The following table contains links to the documentation referenced in this Application Operations Guide.

Table 29
Technical Operations Manual for SAP NetWeaver help.sap.com/nw703 under | SAP NetWeaver »
Administrator’s Guide » Technical Operations for SAP
NetWeaver 3 or help.sap.com/nw74 under [ SAP
NetWeaver » System Administration and Maintenance
Information » Technical Operations for SAP NetWeaver 3
Application Operations Guide for SAP ERP |» service.sap.com/instguides » SAP Business Suite
Applications » SAP ERP » SAP ERP 6.0 » Operations 3
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A.1l.3 External Messages

For information about external messages, see section External Messages in the Application Operations Guide for
SAP Supply Chain Management (SAP SCM).
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B Reference

B.1 The Main SAP Documentation Types

The following is an overview of the most important documentation types that you need in the various phases in
the life cycle of SAP software.

Cross-Phase Documentation
SAPterm is SAP’s terminology database. It contains SAP-specific vocabulary in over 30 languages, as well as
many glossary entries in English and German.
® Targetgroup:
©  Relevant for all target groups
®  Current version:
©  On SAP Help Portal at |p help.sap.com  Glossary 1
© Inthe SAP system in transaction STERM
SAP Library is a collection of documentation for SAP software covering functions and processes.
® Targetgroup:
o Consultants
o System administrators
©  Project teams for implementations or upgrades
e Current version:
©  On SAP Help Portal at help.sap.com (also available as documentation DVD)

The security guide describes the settings for a medium security level and offers suggestions for raising security
levels. A collective security guide is available for SAP NetWeaver. This document contains general guidelines and
suggestions. SAP applications have a security guide of their own.

® Target group:
o System administrators
©  Technology consultants
o Solution consultants

e Current version:

o On SAP Service Marketplace at service.sap.com/securityguide

Implementation

The master guide is the starting point for implementing an SAP solution. It lists the required installable units for
each business or IT scenario. It provides scenario-specific descriptions of preparation, execution, and follow-up of
an implementation. It also provides references to other documents, such as installation guides, the technical
infrastructure guide and SAP Notes.

® Target group:
©  Technology consultants
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o Project teams for implementations
® Current version:
©  On SAP Service Marketplace at service.sap.com/instguides

The installation guide describes the technical implementation of an installable unit, taking into account the
combinations of operating systems and databases. It does not describe any business-related configuration.

® Target group:
©  Technology consultants
o Project teams for implementations
® Current version:
©  On SAP Service Marketplace at service.sap.com/instguides

Configuration Documentation in SAP Solution Manager — SAP Solution Manager is a life-cycle platform. One of
its main functions is the configuration of business scenarios, business processes, and implementable steps. It
contains Customizing activities, transactions, and so on, as well as documentation.

® Targetgroup:

o  Technology consultants

o Solution consultants

o Project teams for implementations
® Current version:

© In SAP Solution Manager

The Implementation Guide (IMG) is a tool for configuring (Customizing) a single SAP system. The Customizing
activities and their documentation are structured from a functional perspective. (In order to configure a whole
system landscape from a process-oriented perspective, SAP Solution Manager, which refers to the relevant
Customizing activities in the individual SAP systems, is used.)

® Targetgroup:

o Solution consultants

©  Project teams for implementations or upgrades
® Current version:

o Inthe SAP menu of the SAP system under |F Tools » Customizing » IMG 3

Production Operation

The technical operations manual is the starting point for operating a system that runs on SAP NetWeaver, and
precedes the application operations guides of SAP Business Suite. The manual refers users to the tools and
documentation that are needed to carry out various tasks, such as monitoring, backup/restore, master data
maintenance, transports, and tests.

® Target group:
o  System administrators
e Current version:
o On SAP Service Marketplace at service.sap.com/instguides

The application operations guide is used for operating an SAP application once all tasks in the technical
operations manual have been completed. It refers users to the tools and documentation that are needed to carry
out the various operations-related tasks.

® Target group:

o System administrators
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o Technology consultants
o Solution consultants
® (Current version:

o On SAP Service Marketplace at service.sap.com/instguides

Upgrade

The upgrade master guide is the starting point for upgrading the business scenarios and processes of an SAP
solution. It provides scenario-specific descriptions of preparation, execution, and follow-up of an upgrade. It also
refers to other documents, such as upgrade guides and SAP Notes.

® Target group:
o  Technology consultants
©  Project teams for upgrades
e Current version:
o On SAP Service Marketplace at service.sap.com/instguides

The upgrade guide describes the technical upgrade of an installable unit, taking into account the combinations of
operating systems and databases. It does not describe any business-related configuration.

® Targetgroup:
o Technology consultants
©  Project teams for upgrades
e Current version:
o On SAP Service Marketplace at service.sap.com/instguides

Release notes are documents that contain short descriptions of new features in a particular release or changes to
existing features since the previous release. Release notes about ABAP developments are the technical
prerequisite for generating delta and upgrade Customizing in the Implementation Guide (IMG).

® Target group:
o Consultants
o Project teams for upgrades
e Current version:
©  On SAP Service Marketplace at service.sap.com/releasenotes
o Inthe SAP menu of the SAP system under [F Help » Release Notes 3 (only ABAP developments)

PUBLIC

© Copyright 2015 SAP SE or an SAP affiliate company. SAP Advanced Planning and Optimization 7.0 Including Enhancement Package 3
70 All rights reserved. Reference


http://service.sap.com/instguides
http://service.sap.com/instguides
http://service.sap.com/instguides
http://service.sap.com/releasenotes

SAP Advanced Planning and Optimization 7.0 Including Enhancement Package 3

PUBLIC
© Copyright 2015 SAP SE or an SAP affiliate company.
All rights reserved.

71



www.sap.com



http://www.sap.com

	SAP Advanced Planning and Optimization 7.0 Including Enhancement Package 3
	Table of Contents
	1   Getting Started
	1.1   Global Definitions
	1.2   Important SAP Notes

	2   Technical System Landscape
	2.1   Scenario/Component Matrix
	2.2   Related Documentation

	3   Monitoring of SAP Advanced Planning and Optimization (SAP APO)
	3.1   Alert Monitoring with CCMS
	3.1.1   CCMS Monitoring Installation and Setup
	3.1.2   Component-Specific Monitoring

	3.2   Detailed Monitoring and Tools for Problem and Performance Analysis
	3.2.1   SAP SCM Basis (Part of SCM Server)
	3.2.2   SAP APO Analysis Tools
	3.2.3   SAP liveCache Technology Analysis Tools
	3.2.4   SAP SCM Optimizer Analysis Tools
	3.2.5   SAP Service Parts Management

	3.3   Data Consistency

	4   Management of SAP APO
	4.1   Starting and Stopping
	4.2   Software Configuration
	4.3   Administration Tools
	4.3.1   SAP APO
	4.3.2   SAP liveCache Technology
	4.3.3   SAP SCM Optimizer

	4.4   Backup and Restore
	4.5   Application Copy
	4.6   Periodic Tasks
	4.6.1   Scheduled Periodic Tasks
	4.6.1.1   SAP SCM Basis (Part of SCM Server)
	4.6.1.2   SAP APO
	4.6.1.3   SAP liveCache Technology
	4.6.1.4   SAP SCM Optimizer
	4.6.1.5   Make to Order for OEM

	4.6.2   Required Manual Periodic Tasks
	4.6.2.1   SAP SCM Basis (Part of SCM Server)
	4.6.2.2   SAP APO
	4.6.2.3   SAP liveCache Technology
	4.6.2.4   SAP SCM Optimizer


	4.7   Load Balancing
	4.8   User Management
	4.9   Printing

	5   High Availability
	6   Software Change Management
	6.1   Transport and Change Management
	6.2   Development Requests and Development Release Management
	6.3   Template Management
	6.4   Quality and Test Management
	6.5   Support Packages and Patch Implementation
	6.6   Release and Upgrade Management

	7   Support Desk Management
	7.1   Remote Support Setup
	7.2   Problem Message Handover

	A   Appendix
	A.1   Appendix
	A.1.1   Related Guides
	A.1.2   Related Information
	A.1.3   External Messages


	B   Reference
	B.1   The Main SAP Documentation Types

	Copyright and Trademarks


